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NASA STI Program . . . in Profile 
 

     Since its founding, NASA has been dedicated to 
the advancement of aeronautics and space science. 
The NASA scientific and technical information (STI) 
program plays a key part in helping NASA maintain 
this important role. 

 
     The NASA STI program operates under the 
auspices of the Agency Chief Information Officer. It 
collects, organizes, provides for archiving, and 
disseminates NASA’s STI. The NASA STI program 
provides access to the NASA Aeronautics and Space 
Database and its public interface, the NASA Technical 
Report Server, thus providing one of the largest 
collections of aeronautical and space science STI in 
the world. Results are published in both non-NASA 
channels and by NASA in the NASA STI Report 
Series, which includes the following report types: 

 
 TECHNICAL PUBLICATION. Reports of 

completed research or a major significant phase 
of research that present the results of NASA 
programs and include extensive data or 
theoretical analysis. Includes compilations of 
significant scientific and technical data and 
information deemed to be of continuing 
reference value. NASA counterpart of peer-
reviewed formal professional papers, but having 
less stringent limitations on manuscript length 
and extent of graphic presentations. 

 
 TECHNICAL MEMORANDUM. Scientific 

and technical findings that are preliminary or of 
specialized interest, e.g., quick release reports, 
working papers, and bibliographies that contain 
minimal annotation. Does not contain extensive 
analysis. 

 
 CONTRACTOR REPORT. Scientific and 

technical findings by NASA-sponsored 
contractors and grantees. 

 

 
 CONFERENCE PUBLICATION. Collected 

papers from scientific and technical 
conferences, symposia, seminars, or other 
meetings sponsored or co-sponsored by NASA. 

 
 SPECIAL PUBLICATION. Scientific, 

technical, or historical information from NASA 
programs, projects, and missions, often 
concerned with subjects having substantial 
public interest. 

 
 TECHNICAL TRANSLATION. English-

language translations of foreign scientific and 
technical material pertinent to NASA’s mission. 

 
     Specialized services also include creating custom 
thesauri, building customized databases, and 
organizing and publishing research results. 
 
     For more information about the NASA STI 
program, see the following: 
 
 Access the NASA STI program home page at 

http://www.sti.nasa.gov 
 
 E-mail your question via the Internet to 

help@sti.nasa.gov 
 
 Fax your question to the NASA STI Help Desk 

at 443-757-5803 
 
 Phone the NASA STI Help Desk at  
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National Aeronautics and  
Space Administration 
 
Langley Research Center   
Hampton, Virginia 23681-2199  

    

July 2011 
 

NASA/TM–2011-217164 
 

 
 

The Multi-Attribute Task Battery II (MATB-II) 
Software for Human Performance and 
Workload Research: A User’s Guide 
 
Yamira Santiago-Espada 
Langley Research Center, Hampton, Virginia 

Robert R. Myer 
Stinger Ghaffarian Technologies, Hampton, Virginia 
 
Kara A. Latorella and James R. Comstock, Jr. 
Langley Research Center, Hampton, Virginia 
 
 
 

 

 



 

Available from: 
 

NASA Center for AeroSpace Information 
7115 Standard Drive 

Hanover, MD 21076-1320 
443-757-5802 

Acknowledgments 

 
The development of MATB-II was possible thanks to the hard work of the development 
team and the help of many others at the NASA Langley Research Center who contributed 
their time, talent, and allocated funding to make this project a success.  Our appreciation 
is extended to colleagues who recorded the audio files, reviewed the Beta testing process, 
allowed us to use NASA facilities for these activities and reviewed the User’s Guide.  
Among those are Lisa O. Rippy, Raymond S. Calloway, B. Danette Allen, Eric Cooper, 
Roger Bailey, Daniel W. Burdette, Samuel C. Hall, Alan T. Pope, Chad L. Stephens, 
Jennifer A. Inman, Kenneth H. Goodrich, Anna C. Trujillo, Patricia G. Cowin, Jeffrey S. 
Hill, Fernandus Rattliff, A. Terry Morris and Wilfredo Torres-Pomales. 
 
The authors appreciate the work performed by many students involved in the 
development of MATB-II. Those people include Joshua Saltar, Jorge L. Herrera, Ryan R. 
Walker and Jacquelyn Gómez. 
 
The feedback of the individuals and institutions that served as beta testers proved to be 
useful, as it led to improvements in the user interface and refinement of the application.  
Thanks to the testing groups of the U.S. Army’s Aberdeen Test Center and the Air Force 
Research Lab, Wright-Patterson Air Force Base for their support. 
 
 

 

 

 

 

 

 

 

The use of trademarks or names of manufacturers in this report is for accurate reporting and does not constitute an 
official endorsement, either expressed or implied, of such products or manufacturers by the National Aeronautics 
and Space Administration.  

 

 



iii

Table of Contents
1 Introduction to the MATB-II User’s Guide ............................................................. 1 
1.1 About the MAT Battery .................................................................................... 2 
1.2 The New MATB ............................................................................................... 2 
1.3 Hardware and software requirements ............................................................. 3 
1.4 About using Video Capture ............................................................................. 3 
1.5 MATB-II Section Guide ................................................................................... 4 
2 Task Overview ...................................................................................................... 5 
2.1 System Monitoring Task .................................................................................. 6 
2.2 Tracking Task .................................................................................................. 8 
2.3 Scheduling Display .......................................................................................... 9 
2.4 Communications Task ................................................................................... 11 
2.5 Resource Management Task ........................................................................ 14 
2.6 Workload Rating Scale .................................................................................. 17 
2.7 Summary of Differences between the MAT Battery and MATB-II ................. 18 
3 Installation and Setup ......................................................................................... 24 
3.1 Installation ..................................................................................................... 24 
3.2 Launching MATB-II ....................................................................................... 30 
3.3 MATB-II Startup Windows ............................................................................. 31 
3.4 Joystick Detection ......................................................................................... 33 
3.5 Operation of MATB-II in Training and Testing Modes ................................... 34 
4 Control of Task Events ....................................................................................... 36 
4.1 The MATB_CONFIG.xml file ......................................................................... 36 
4.1.1 Elements of the MATB_CONFIG.xml file ...................................................... 36 
4.1.2 MATB-II operational modes ........................................................................... 38 
4.1.3 Timeout Values ............................................................................................. 39 
4.1.4 Recording Intervals ....................................................................................... 40 
4.1.5 Creating and Saving a Customized Configuration File .................................. 41 
4.2 The MATB_EVENTS.xml File ....................................................................... 41 
4.2.1 Editing the Events File Manually ................................................................... 42 
4.2.2 MATB-II Events File Structure ....................................................................... 42 
4.2.3 SYSMON and RESMAN Activation ............................................................... 44 
4.2.4 Setting up System Monitoring Events ........................................................... 44 
4.2.4.1 System Monitoring Light Events .................................................................... 45 
4.2.4.2 System Monitoring Scale Events ................................................................... 46 



iv

4.2.5 Tracking Task Events .................................................................................... 47 
4.2.6 Scheduling of a Communications Session .................................................... 48 
4.2.7 Communications Events ............................................................................... 49 
4.2.8 Resource Management Events ..................................................................... 51 
4.2.9 Workload Rating Scale (WRS) Events .......................................................... 52 
4.2.10 Naming and Saving the MATB_EVENTS.xml file .......................................... 52 
5 Understanding Output Data Files ....................................................................... 53 
5.1 Naming conventions ...................................................................................... 53 
5.2 Commonalities among the data file headers ................................................. 54 
5.3 The MATB output file .................................................................................... 55 
5.4 The System Monitoring output file ................................................................. 56 
5.5 The Tracking output file ................................................................................. 58 
5.6 The Communications output file .................................................................... 58 
5.7 The Resource Management output file ......................................................... 60 
5.8 The Workload Rating Scale output file .......................................................... 61 
6 Basic Steps for Initiating a MATB-II Study .......................................................... 62 
7 Example Instructions to be provided to Subjects for operating MATB-II ............. 63 
7.1 System Monitoring (SYSMON) Task ............................................................. 64 
7.2 Tracking (TRACK) Task ................................................................................ 65 
7.3 Communications (COMM) Task .................................................................... 66 
7.4 Resource Management(RESMAN) task ........................................................ 68 
7.5 Scheduling Display (SCHED) ........................................................................ 71 
7.6 Workload Rating Scale (WRS) ...................................................................... 72 
8 References ......................................................................................................... 75 
9 MATB Reference List (Selected Publications From 2003-2010) ........................ 76 

 
Appendices 

 
A MATB Configuration File ...................................................................................... 1 
A.1 MATB_CONFIG.xml ........................................................................................ 2 

A.2 MATB Modes .................................................................................................. 3 

A.2.1 MATB Auto Minimize Mode ............................................................................. 5 
A.2.2 MATB Auto Start Mode ................................................................................... 6 
A.2.3 MATB Select Events File Mode ....................................................................... 7 
A.2.4 MATB Set Run Parameters Mode ................................................................... 8 



v

A.2.5 MATB Testing Mode ....................................................................................... 9 
A.2.6 MATB Training Mode .................................................................................... 11 
A.2.7 MATB Task Border Mode .............................................................................. 13 
A.3 Resource Management Rates ....................................................................... 15 

A.4 Timeout Values ............................................................................................. 16 

A.4.1 Recording Intervals ....................................................................................... 17 

B MATB Events File ............................................................................................... 18 
B.1 MATB_EVENTS.xml Opening Entries ........................................................... 19 

B.2 MATB_EVENTS.xml Closing Entries ............................................................ 20 

B.3 COMM State Change Entries ........................................................................ 21 

B.4 RESMAN State Change Entries .................................................................... 22 

B.5 SYSMON State Change Entries .................................................................... 23 

B.6 TRACK State Change Entries ....................................................................... 24 

B.7 RATE State Change Entry ............................................................................ 25 

C MATB Menu Operations ..................................................................................... 26 
C.1 File & Help Menu Items ................................................................................. 26 

C.2 File, Train, Test & Help Menu Items .............................................................. 27 

C.3 File -> Exit Menu Item ................................................................................... 28 

C.4 File -> Start Menu Item .................................................................................. 29 

C.5 File -> Start Dialog ........................................................................................ 30 

C.6 Help Menu Items ........................................................................................... 31 

C.7 Help -> About Dialog ..................................................................................... 32 

C.8 Help -> Tasks Menu Items ............................................................................ 33 

C.9 Help -> Tasks -> COMM Dialog .................................................................... 34 

C.10 Help -> Tasks -> WRS Dialog ....................................................................... 35 

C.11 Help -> Tasks -> RESMAN Dialog ................................................................ 36 

C.12 Help -> Tasks -> SCHED Dialog ................................................................... 37 

C.13 Help -> Tasks -> SYSMON Dialog ................................................................ 38 

C.14 Help -> Tasks -> TRACK Dialog ................................................................... 39 

C.15 Help -> Version Dialog .................................................................................. 40 

C.16 Test -> All Menu Items .................................................................................. 41 

C.17 Test -> Communications Menu Items ............................................................ 42 



vi

C.18 Test -> Resource Management Dialog .......................................................... 43 

C.19 Test -> Tracking Dialog ................................................................................. 44 

C.20 Test -> Timeouts Dialog ................................................................................ 45 

C.21 Test -> View Events List ................................................................................ 46 

C.22 Test -> View Schedule List ............................................................................ 47 

C.23 Test -> Workload Rating Scale ..................................................................... 48 

C.24 Train Menu Items .......................................................................................... 49 

C.25 Train -> Communications Dialog ................................................................... 50 

C.26 Train -> Workload Rating .............................................................................. 51 

D Communications Task ........................................................................................ 52 
D.1 COMM Initial State ........................................................................................ 53 

D.2 COMM Session Initial State .......................................................................... 54 

D.3 COMM Session Start Event .......................................................................... 55 

D.4 COMM Session Started................................................................................. 55 

D.5 COMM OWN COM1 Event ............................................................................ 56 

D.6 COMM OWN COM1 Event Handled ............................................................. 56 

D.7 COMM OWN COM1 Changed Entered ......................................................... 57 

D.8 COMM OTHER NAV2 Event ......................................................................... 58 

D.9 COMM OTHER COM2 Event Handled.......................................................... 58 

D.10 Output File Entries for COMM Events ........................................................... 59 

E Resource Management Task ............................................................................. 62 
E.1 RESMAN Event to Include Task ................................................................... 63 

E.2 RESMAN Initial State .................................................................................... 64 

E.3 RESMAN Selected Pumps Activated By User .............................................. 65 

E.4 RESMAN Event to Fail a Pump ..................................................................... 66 

E.5 RESMAN Pump ONE Failed ......................................................................... 67 

E.6 RESMAN Event to Fix a Pump ...................................................................... 68 

E.7 RESMAN Pump ONE Fixed .......................................................................... 69 

E.8 Output File Entries for RESMAN Events ....................................................... 70 

F System Monitoring Task ..................................................................................... 72 
F.1 SYSMON Initial State .................................................................................... 73 

F.2 SYSMON Event to Activate the Normal State ............................................... 74 



vii

F.3 SYSMON Normal State ................................................................................. 75 

F.4 SYSMON Event to Turn the GREEN Light OFF ............................................ 75 

F.5 SYSMON GREEN Light OFF Event .............................................................. 76 

F.6 SYSMON Event to Turn the RED Light ON ................................................... 76 

F.7 SYSMON RED Light ON Event ..................................................................... 77 

F.8 SYSMON Event to Move Scale Two DOWN ................................................. 77 

F.9 SYSMON Scale Two DOWN UP ................................................................... 78 

F.10 SYSMON Event to Move Scale Three UP..................................................... 78 

F.11 SYSMON Scale Three UP ............................................................................ 79 

F.12 SYSMON Return to the Normal State ........................................................... 80 

F.13 Output File Entries for SYSMON Events ....................................................... 81 

G Tracking Task ..................................................................................................... 83 
G.1 TRACK Initial State ....................................................................................... 84 

G.2 TRACK Session Schedule ............................................................................ 85 

G.3 TRACK Session Manual Event ..................................................................... 86 

G.4 TRACK Manual Session Started ................................................................... 87 

G.5 TRACK Manual Session – Target Drift .......................................................... 88 

G.6 TRACK Manual Session – Target Caged ...................................................... 88 

G.7 TRACK Manual Session – Target Controlled ................................................ 89 

G.8 TRACK Session Auto Event .......................................................................... 90 

G.9 Output File Entries for TRACK Events .......................................................... 91 

H Workload Rating Scale ....................................................................................... 93 
H.1 WRS Event to Launch the Questionnaire ...................................................... 94 

H.2 WRS Initial Display State .............................................................................. 95 

H.3 WRS Completed Display State (Example) .................................................... 96 

H.4 Output File Entries for WRS Events .............................................................. 97 

I Recording Interval Output File Entries ................................................................ 99 
I.1 Output File Entries for Joystick Device ........................................................ 100 

I.2 Output File Entries for TRACK Task Interval Recordings ............................ 101 

I.3 Output File Entries for RESMAN Task Interval Recordings......................... 102 

I.4 Lost Focus and Run Paused Output File Entries ........................................ 103 

 



viii

J Error and Warning Messages ........................................................................... 104 
J.1 Error Message – Configuration File Not Found ........................................... 105 

J.2 Error Message – Event Start Time Sequence Error .................................... 106 

J.3 Error Message – Scheduling Pairs Errors ................................................... 107 

J.4 Error Message – Maximum Run Length Exceeded ..................................... 108 

J.5 Error Message – Required Control Event Missing ...................................... 109 

J.6 Warning Message – No Joystick Found ...................................................... 110 

J.7 Warning Message – COMM Audio File Not Found ..................................... 111 

J.8 Information Message – Timestamp Already Used ....................................... 112 

K MATB-II Microsoft Compiled HTML Help .......................................................... 114 
L User Guide for Creating Events Files ............................................................... 115 
L.1 Using Worksheets and Templates .............................................................. 116 
L.2 Creating an Events File Step By Step ......................................................... 117 
L.3 Experiment Worksheet ................................................................................ 118 
L.4 Events Worksheet ....................................................................................... 119 
L.5 Sample Events Worksheet Entries for a COMM Event ............................... 120 
L.6 Sample Events Worksheet Entries for a Workload Rating Scale Event ...... 120 
L.7 Sample Events Worksheet Entries for a RESMAN Event ........................... 121 
L.8 Sample Events Worksheet Entries for a SCHED Event .............................. 122 
L.9 Sample Events Worksheet Entries for a SYSMON Event ........................... 123 
L.10 MATB_EVENTS-template-start.xml ............................................................ 124 
L.11 MATB_EVENTS-template-comm.xml ......................................................... 125 
L.12 MATB_EVENTS-template-resmon.xml ....................................................... 127 
L.13 MATB_EVENTS-template-sched.xml .......................................................... 130 
L.14 MATB_EVENTS-template-sysmon.xml ....................................................... 132 
L.15 MATB_EVENTS-template-track.xml ........................................................... 134 
M COMM Audio Filenames .................................................................................. 135 
N Crimson Editor Screen Capture of a MATB_EVENTS File ............................... 137 
N.1 XML Notepad 2007 Screen Capture of a MATB_EVENTS File .................. 138 
O A complete MATB_II_*.txt output file for a 5 minute run ................................... 139 
P A complete MATB_EVENTS file ....................................................................... 142 
P.1 MATB_EVENTS-sample-5min.xml .............................................................. 149 
P.2 Appendix CONTROL.xml ............................................................................ 152 
P.3 Appendix RESMAN.xml .............................................................................. 153 



ix

Q Multi-Attribute Task Battery (MATB) Communications Task Audio Scripts and 
Filenames ......................................................................................................... 154 

Q.1 Scripts / Audio Filename Pairs .................................................................... 156 
Q.1.1 NASA 504 Communications radio number ONE ......................................... 156 
Q.1.2 NASA 504 Communications radio number TWO ........................................ 157 
Q.1.3 NASA 504 Navigation radio number ONE ................................................... 158 
Q.1.4 NASA 504 Navigation radio number TWO .................................................. 159 
Q.1.5 Other Ship Communications radio number ONE ......................................... 160 
Q.1.6 Other Ship Communications radio number TWO ........................................ 161 
Q.1.7 Other Ship Navigation radio number ONE .................................................. 162 
Q.1.8 Other Ship Navigation radio number TWO .................................................. 163 
Q.1.9 Airline Call Signs ......................................................................................... 164 
Q.1.10 FAA Radiotelephony Phonetic Alphabet with Pronunciation ....................... 165 
Q.1.11 Audio Filename with Corresponding Events File Entry ............................... 166 



1

1 Introduction to the MATB-II User’s Guide 

  



2

1.1 About the MAT Battery 
 

1.2  The New MATB 
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1.3 Hardware and software requirements 
 

1

1.4  About using Video Capture 
 

1  The route followed by an operating system to find the location of a stored file. The search path begins with a 
drive or volume (disk) designator or a network share, continues through a chain of directories and 
subdirectories, if any, and ends with the file name. C:\books\diction\start.exe is an example of a search path. 
Also called: access path   
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1.5  MATB-II Section Guide 
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2 Task Overview 
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2.1  System Monitoring Task 
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2.2  Tracking Task 
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2.3  Scheduling Display 
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2.4   Communications Task 
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2.5 Resource Management Task 
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2.6 Workload Rating Scale 
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2.7 Summary of Differences between the MAT Battery and 
MATB-II 
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2  A Lissajous pattern is the looping patterns generated by a Cathode Ray Tube spot when the 
horizontal (X) and vertical (Y) deflection signals are sinusoids. The Lissajous pattern is useful for 
evaluating the delay or phase of two sinusoids of the same frequency. 



21



22

<!-- SYSMON SCALES -->
<!-- System Monitoring - Move SCALE THREE UP -->
<event startTime=" 0:22:19 ">

<sysmon>
<monitoringScaleNumber>THREE</monitoringScaleNumber>
<monitoringScaleDirection>UP</monitoringScaleDirection>

</sysmon>
</event>   
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3 Installation and Setup 
3.1 Installation 
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3.2  Launching MATB-II 
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3.3  MATB-II Startup Windows 
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3.4  Joystick Detection
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3.5 Operation of MATB-II in Training and Testing Modes 
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4   Control of Task Events 
 

4.1 The MATB_CONFIG.xml file 
 

4.1.1 Elements of the MATB_CONFIG.xml file 
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4.1.2     MATB-II operational modes 
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4.1.3 Timeout Values 

<!-- Time Out in seconds... -->
<name type="TIMEOUT">
<RATE>30</RATE>
<TASK_COMM>30</TASK_COMM>
<TASK_SYSMON_SCALES>10</TASK_SYSMON_SCALES>
<TASK_SYSMON_LIGHTS>15</TASK_SYSMON_LIGHTS>
</name> 
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4.1.4 Recording Intervals 

<!-- Recording Interval in seconds... -->
<name type="RECORDING_INTERVAL">
<TASK_TRACK>15</TASK_TRACK>
<TASK_RESMAN>30</TASK_RESMAN>
</name>
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4.1.5 Creating and Saving a Customized Configuration 
File

4.2 The MATB_EVENTS.xml File 
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4.2.1 Editing the Events File Manually 
 

4.2.2 MATB-II Events File Structure 
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<MATB_EVENTS>
<!-- Start MATB Timer -->
<event startTime="0:00:00">

<control>START</control>
</event>

</MATB_EVENTS>

<MATB_EVENTS>
<!-- Stop MATB Timer and 
end experiment -->

<event startTime="0:20:00">
<control>END</control>

</event>
</MATB_EVENTS>

<event

startTime="h:mm:ss">

event

startTime="0:20:00"

<MATB_EVENTS>
<!—Rest of the code -->
</MATB_EVENTS>
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4.2.3 SYSMON and RESMAN Activation 

<!-- Start Resource Management and System 
monitoring tasks -->

<event startTime="h:mm:ss">
<sched>

<task>RESSYS</task>
<action>START</action>
<update>NULL</update>
<response>NULL</response>

</sched>

4.2.4 Setting up System Monitoring Events 
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4.2.4.1 System Monitoring Light Events  

<!-- SYSMON LIGHT -->
<!-- System Monitoring - Turn Normally ON to OFF -->
<event startTime="h:mm:ss">

<sysmon>
<monitoringLightType>GREEN</monitoringLightType>

</sysmon>
</event>
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4.2.4.2 System Monitoring Scale Events 

<!-- SYSMON SCALES -->
<!-- System Monitoring - Move SCALE FOUR UP -->
<event startTime=" h:mm:ss ">

<sysmon>
<monitoringScaleNumber>FOUR</monitoringScaleNumber>
<monitoringScaleDirection>UP</monitoringScaleDirection>

</sysmon>
</event   

<!-- SYSMON SCALES -->
<!-- System Monitoring - Move SCALE ONE DOWN -->
<event startTime=" h:mm:ss ">

<sysmon>
<monitoringScaleNumber>ONE</monitoringScaleNumber>
<monitoringScaleDirection>DOWN</monitoringScaleDirection>

</sysmon>
</event   

   <!-- SYSMON LIGHT -->
<!-- System Monitoring - Turn Normally OFF to ON -->
<event startTime=" h:mm:ss ">

<sysmon>
<monitoringLightType>RED</monitoringLightType>

</sysmon>
</event>
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4.2.5 Tracking Task Events 

 <!-- #  TRACK MANUAL -->
<!-- Sched task: TRACK START -->
<event startTime="0:00:05">

<sched>
<task>TRACK</task>
<action>MANUAL</action>
<update>MEDIUM</update>
<response>MEDIUM</response>

</sched>
</event>
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<!--  TRACK AUTO -->
<!--  Sched task: TRACK STOP -->
<event startTime="h:mm:ss">
  <sched>

<task>TRACK</task>
<action>AUTO</action>
<update>NULL</update>
<response>NULL</response>

  </sched>
</event>

4.2.6 Scheduling of a Communications Session 

 
<!--Start Communications task -->
<event startTime="h:mm:ss">

<sched>
<task>COMM</task>
<action>START</action>
<update>NULL</update>
<response>NULL</response>

</sched>
</event>

<!-- Sched task: COMM STOP -->
<event startTime=="h:mm:ss">

<sched>
<task>COMM</task>
<action>STOP</action>
<update>NULL</update>
<response>NULL</response>

</sched>
</event>



49

4.2.7 Communications Events 

 

<!-- COMM OTHER -->
<!-- Other ship radio change -->
<event startTime=" 0:05:15 ">

<comm>
<ship>OTHER</ship>
<radio>COM2</radio>
<freq>118.275</freq>

</comm>
</event>

 

<!--  Own ship radio change -->
<event startTime="0:06:31">
  <comm activity="START">

<ship>OWN</ship>
<radio>COM1</radio>
<freq>127.550</freq>

</comm>
</event>
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4.2.8 Resource Management Events 

<!-- Start Resource Management and System 
monitoring tasks -->

<event startTime="0:00:00">
<sched>

<task>RESMAN</task>
<action>START</action>
<update>NULL</update>
<response>NULL</response>

</sched>

<!-- RESMAN PUMP FAIL -->
<!-- RESMAN task: fail pump 1  -->
<event startTime="0:07:22">
 <resman>

<fail>P1</fail>
</resman>

</event>
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<!-- RESMAN PUMP FIX -->
<!-- RESMAN task: fix pump 1  -->
<event startTime="0:07:57">

<resman>
<fix>P1</fix>

</resman>
</event>

4.2.9 Workload Rating Scale (WRS) Events 

<!--  Workload Rating  -->  
<event startTime="1:10:30"> 
 <wrs>START</wrs> 
 </event> 

4.2.10 Naming and Saving the MATB_EVENTS.xml file 
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5 Understanding Output Data Files 
5.1 Naming conventions 
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5.2 Commonalities among the data file headers 
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5.3 The MATB output file 
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5.4 The System Monitoring output file 
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5.5 The Tracking output file 

5.6 The Communications output file 
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5.7 The Resource Management output file 
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5.8 The Workload Rating Scale output file 
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6 Basic Steps for Initiating a MATB-II Study 
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7 Example Instructions to be provided to Subjects for 
operating MATB-II 
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7.1 System Monitoring (SYSMON) Task  
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7.2  Tracking (TRACK) Task 
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7.3  Communications (COMM) Task 
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7.4 Resource Management (RESMAN) task 
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Fuel level of Tank A. Tanks A 
and B are main tanks.

Fuel level of Tank B.

Tanks E and F are 
supply tanks that don’t 
run out of fuel. Fuel 
levels are not shown for 
Tanks E and F. 

Fuel level of 
Tank D. 
Tank D is a 
supply tank. 

Pump 
ID
Colum

Pump 
Flow
Rate
Column 
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7.5 Scheduling Display (SCHED) 



72

7.6 Workload Rating Scale (WRS) 
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8 References 

Search path.
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9 MATB Reference List (Selected Publications From 
2003-2010)
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Appendix Page 1 

User’s Guide Appendix to the Multi-Attribute Task Battery 
Technical Memorandum 

A MATB Configuration File 

The filename of the MATB configuration file is MATB_CONFIG.xml. This file contains four 
different types of configuration data used by the application. First is a set of seven Boolean modes 
which selectively control the functionality of MATB based upon user desires. Second are the 
resource management task (RESMAN) pump volumetric values and main tank consumption rates in 
units per minute.  Next is a set of timeout values in seconds for the communications (COMM) and 
system monitoring (SYSMON) tasks. The lights and scales have independent timeout values. The 
workload rating questionnaire also has a timeout value. If the subject does not respond within the 
time period the event expires and an appropriate entry is made to the output file. Lastly, certain 
tracking and resource management state data is recorded at the time interval specified. For the 
tracking (TRACK) task, the Root Mean Square Deviation from the Center Point in Pixel Units 
(RMSD-C) is calculated and recorded along with the number of samples during the interval. For the 
resource management task, the tank volumes and pumps state are recorded at the end of each time 
interval. This is in addition to the entries made when the subject turns a pump on or off. 
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A.1 MATB_CONFIG.xml 

Item # Name Type Description 

 
MODE Seven Booleans modes set the functionality of MATB. 

 
RESMAN RATES The rates per minute of each of the eight pumps and the consumption rates per minute of 

the primary tanks. 

 
TIMEOUT Timeout values in seconds for the Workload Rating Scale, COMM and SYSMON tasks. 

 
RECORDING 
INTERVAL 

The recording interval in seconds for the TRACK and RESMAN tasks.  4

3

2

1

1

2

3

4
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A.2 MATB Modes 

The seven modes are: 
1. “Automatic Minimize” when another application takes the focus away from MATB. 
2. “Automatic Start” of a run once initialization is completed. 
3. “Select Eventsfile” from a file dialog and not default to MATB_EVENTS.xml.
4. “Set Run Parameters” provides a dialog of sliders to overload the values in the 
MATB_CONFIG.xml. Intended for use during experiment design. 
5. “Training Mode” provides visual cues and menu choices to the subject not normally available 
during a data collection run. 
6. “Test Mode” provides visual cues and menu choices to the experiment designer not normally 
available during a data collection run. 
7.  “Task Border Mode” adds a blue column between the tasks to serve as a visual separator when set 
to True. As glass flight deck aircraft do not use these types of separators, the default is false.  
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Item # Mode Name Description 

 
Auto Minimize When true MATB will automatically minimize if it loses the focus to another 

process. For making screen captures, the value must be false. 

 
Auto Start When true the run automatically starts, but when false a dialog asks the user for 

acknowledgement to start the run. During training it may be useful to set to false, 
but during data collection normally this mode should be true. 

 
Select Events file  Provides the option to select an events file other than “MATB_EVENTS.xml” in the 

format “MATB_EVENTS-xxxxxx.xml” where “xxxxxx” is a user assigned suffix to 
indentify the file contents.  

 
Set Run Parameters Allows the user to overload the resource management task pump rate and tank 

consumption values. Uses sliders so the user may enter a value outside the defined 
range. Also allows the same for timeouts and recording intervals.  

 
Training  Adds a “Train” menu which allows the user to play sample communications task 

audio files and complete a workload rating evaluation. Additionally, displays visual 
cues within white text boxes not available when not training or testing.  

 
Testing Adds a “Test” menu which allows the experiment designer to verify that the sound 

card and joystick are installed and working. Event and configuration values for the 
run may also be verified. Additionally displays visual cues within white text boxes 
not available when not training or testing.   

 
Task Borders Adds blue columns on either side of the TRACK task and between the COMM and 

RESMAN tasks. 
7
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A.2.1 MATB Auto Minimize Mode  

Item # Boolean Description 

 
true When another process (the browser in this case) gets the focus, MATB minimizes 

to the tray. The timers are paused. 

 
false When another process (the browser in this case) gets the focus, MATB remains on 

the screen. The timers are paused. 
2
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A.2.2 MATB Auto Start Mode  

   

Item # Boolean Description 

 
true Run elapsed timer starts as soon as MATB is initialized. 

 
false User starts the application by selecting Start from the File menu, followed by 

selecting Yes on the dialog.  
2

1

1

2
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A.2.3 MATB Select Events File Mode  

Item # Boolean Description 

 
true 

Dialog opens to the XML folder with MATB_EVENTS.xml as the default filename. 
User may pick another file with the correct format if desired.  
In this example, MATB_EVENTS-2min-TM.xml, a file created for a specific 
purpose, may also be chosen.  
 
Note: The Windows default on the first use after an installation is the last 
folder accessed (e.g. before MATB was installed), but once you select a file from 
the \MATB\XML folder, this folder becomes the opening location for MATB.

 
false The default value for this mode. MATB_EVENTS.xml is opened and read. 

Once the flow of events for a run have been finalized, it is recommended that the 
file be renamed to MATB_EVENTS.xml and this Boolean set to true. 

2

1

1

1

2
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A.2.4 MATB Set Run Parameters Mode  

Item # Boolean Description 

 
true A tabbed dialog is displayed, which allows the user to change the pump flow rates, 

tank consumption rates, recording intervals and event timeouts read from  
MATB_CONFIG.xml. Buttons are available to Cancel, Reset All and Save All. This 
mode is intended for use during experiment design. Once the desired values are 
determined and set in MATB_CONFIG.xml, this value should be changed to false.  

            

 

false No dialog is displayed and the values in MATB_CONFIG.xml are used. If 
MATB_CONFIG.xml does not contain any resource management pump and tank 
values, timeouts or recording intervals, the default values within MATB are used.  

2

1

1

1

1
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A.2.5 MATB Testing Mode  

Item # Boolean Description 

 
true Menu item allowing selections to play sample audio files, view resource 

management rates, timeout values, joystick test. The user may also see a time 
sequenced list of the run events and scheduled communications and tracking 
sessions. May also activate a workload rating session.  White background text 
boxes provide additional state data feedback. Selecting the “?” from the title bar 
launches MATB_Documentation.chm. 

 
false No menu item or state data feedback boxes.  The “?” selection is only available in 

testing mode. 
2
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A.2.6 MATB Training Mode  

Item # Boolean Description 

 
true Menu item allowing selections to play sample audio files. May also activate a 

workload rating session.  White background text boxes provide additional state data 
feedback. “Radio” and “Frequency” column labels are displayed on the COMM task.  
Tank A and B consumption rates are displayed on the RESMAN task above and to 
either side of the Pump 7 button controller. 

 
false No menu item or state data feedback boxes. 2

1

1

1

1

1

1 1
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A.2.7 MATB Task Border Mode  

Item # Boolean Description 

 
false This is the default. The display has no visual dividers between the tasks. 

 
true Blue columns are displayed between the tasks 2

1

1

1

1

1
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A.3 Resource Management Rates 

MATB internally sets the following default pump flow and primary tank consumption rates in units 
per minute: 
PUMP 1 = 800;    PUMP_2 = 600;    PUMP_3 = 800;    PUMP_4 = 600
PUMP_5 = 600;   PUMP_6 = 600 ;   PUMP_7 = 400;    PUMP_8 = 400
TANK_A = 800;  TANK_B = 800  
The user may select different rate values within the range 0-1000 units per minute through the 
MATB_CONFIG.xml.
They may also have the opportunity to change these values through a dialog if the Set Parameters 
mode is true (see appendix A.2 number 4 above). These changes are only intended to be used during 
scenario development.  

Item # Resource Description 

 
Pumps The flow rate in units per minute at which a pump moves fuel from one tank to 

another. 

 
Tanks The volume in units per minute that the primary tanks consume (i.e. supply to the 

virtual engines) 
2

1

1

2
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A.4 Timeout Values 

The subject is allowed a variable number of seconds to respond to a processed event. Specifically, 
the playing of a communications task sound file instructing the subject to set a radio frequency, or 
the subject responding to the other tasks visually changing from the normal state. The maximum 
allowed response time is 60 seconds. The minimum response time is 10 seconds, which is also in the 
default if not changed through the MATB_CONFIG.xml file or through the dialog if the Set 
Parameters mode is true (see appendix A.1). If a time outside the 10-60 second range is read from 
the MATB_CONFIG.xml file, the default value (30 seconds) is used.
Note: A timer begins as soon as the event is processed. For a COMM event, the timer may already 
have reached 10 seconds before the audio instruction is completed. This is the reason the COMM 
timeout is much longer than the SYSMON timers. 

Item # Timeout Description 

 
Rate In this instance the subject has 30 seconds to complete the Workload Rating 

Questionnaire before the dialog timeouts. 

 
Communications  Task The subject has 30 seconds (default) to respond to the message in the audio file. If 

the message is directed to a ship other than our own the instructions should be 
ignored and the event times out. In this case this is the correct response. 

 
System Monitoring 
Scales 

Normally a scale moves up and down randomly in the center region, but by event it 
either shifts to the upper or lower region. In this instance the subject is given 10 
seconds to respond to the event. 

 
System Monitoring Lights Normally the Green light is on and the Red light is off. A light event toggles the 

state of one of the lights. In this instance the subject has 15 seconds (default) to 
respond by returning the light to the normal state.   

4
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1 3
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A.4.1 Recording Intervals 

In addition to recording event processing and subject responses, state data is periodically recorded 
for both the tracking and resource management tasks. State data is only recorded for the tracking 
task when it is in manual mode (i.e. the subject is controlling the target position with a joystick).  For 
the tracking task, the Root Mean Square Deviation from the Center Point in Pixel Units (RMSD-C) 
is calculated and recorded along with the number of samples during the interval. For the resource 
management task the volumes of tanks A through D are recorded.

Item # Task Description 

 
Tracking  In this instance the RMSD-C, number of samples since the last recording and the 

total sum of the squares of the deviation from center are recorded every 15 
seconds while in manual mode. 

 
Resource Management The current tank volume will be recorded every 30 seconds in this instance 2

1

1

2
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B MATB Events File 

During a run, subjects respond to MATB time sequenced task state changes, known as events.  The 
list of events is contained in an Extensible Markup Language (XML) File with the default filename 
of MATB_EVENTS.xml. The default may be overloaded with an entry in the 
MATB_CONFIG.xml, see appendix A.2.3.  Each run starts with each task in a normal state and 
changes to a non-normal state when the appropriate event is triggered.  The normal state for the 
communications (COMM) task is each of four radios tuned to a specified frequency. The non-
normal state starts with the instructions from an audio to change the frequency on one of the four 
radios.  The instruction may be directed to the subject (call sign “NASA 504”) in which case the task 
is to comply, or to another aircraft in which case the instruction is ignored.  The normal state for the 
system monitoring (SYSMON) task is for the Green light to be on, the Red light off, and each of the 
four scales to randomly move within the center region of the scale. The non-normal state is the 
Green light to go off, or the Red light to come on, or one of the scales to either randomly shift to the 
top or bottom region.  The system is returned to the normal state by one of several mouse clicks or 
key strokes.  The normal state of the tracking (TRACK) task is for the target (blue dot with a circle) 
to randomly automatically move within the inner square.   In the non-normal state the subject 
controls the position with a joystick.  The normal state for the resource management (RESMAN)
task is for the subject to control the volume of tanks A and B with one or more of eight pumps. In 
the non-normal state, one or more of the pumps is broken and does not contribute to the effort. In 
addition to the four tasks, there is a visual indicator of the session state of the COMM and TRACK
tasks. While the SYSMON and RESMAN tasks are active for the entire run once initialized, the 
COMM and TRACK tasks can be in either an active or inactive state.  While in the inactive state no 
events are processed, and when they are active it is called a session.  A look-ahead session bar is 
shown on the control panel on the upper right of the display. Active sessions are shown with a thick 
green bar and the normal state by a thin red line. Additionally the subject may be asked to complete 
a workload ratings questionnaire (RATE), which is also triggered by an event.

Examples of the events file entries follow. 
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B.1 MATB_EVENTS.xml Opening Entries 

Item # Event Type Description 

startTime 
Every event has a startTime attribute. It is the elapsed time since the start of the run. The 
timer is stopped whenever the Workload Rating dialog is opened, MATB losses the focus, a 
Menu dialog is open, etc. 

 
CONTROL Starts the run and turns on the elapsed time counter. 

 
SCHED Both the RESMAN and SYSMON tasks are started by the keyword RESSYS. Both tasks 

remain active for the entire run. 

 
SCHED Starts a manual TRACK task.  The target position is updated by MATB at the high rate, 

while the joystick response to the subjects input is at the medium rate. 

 
SYSMON Turns OFF the normally ON Green light. 

 
SCHED Starts a COMM task session at a run elapsed time of 0 hours, 0 minutes and 34 seconds. 6

5

4

3

2

1

2

3

4

5

6

1



Appendix Page 20 

B.2 MATB_EVENTS.xml Closing Entries 

Item # Event Type Description 

 
SCHED Stops MANUAL tracking, and returns the TRACK task to the automatic or normal state 

 
SYSMON Changes light state, in this case the GREEN light which is normally ON, turns OFF, or the 

RED light is turned ON. 

 
SCHED Ends a COMM session.  

 
CONTROL Ends the run 4

3
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B.3 COMM State Change Entries 

Item # COMM   
Event Type� Description 

 
OWN At a run elapsed time of one minute and twenty seconds an audio file instructing NASA 504 

to change the COM1 radio to frequency 131.050 is played. The subject should comply. 

 
OTHER At a run elapsed time of one minute and fifty five seconds an audio file instructing an aircraft 

with some other call sign to change the NAV2 radio to frequency 112.550 is played. Since 
the subject only responds to instructions for NASA 504, this instruction should be ignored.  

2

1

1

2
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B.4 RESMAN State Change Entries 

Item # RESMAN  
Event Type� Description 

 
fail At a run elapsed time of no minutes and five seconds pump two is failed. If the subject 

previously turned pump two on, it will be turned off.  Any attempts to turn pump two on while 
it is failed will not succeed. The color of pump two will change to red.  

 
fix At a run elapsed time of two minutes and five seconds pump one is fixed. The color of the 

pump changes to gray. If the subject turns pump two on, it will begin pumping and the color 
turns green.   

2

1

2
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B.5 SYSMON State Change Entries 

Item # SYSMON 
Event Type Description 

 
GREEN The GREEN light, which is normally ON, turns OFF 

 
RED The RED light, which is normally OFF, turns ON 

 
ONE UP The random cycling of scale ONE shifts from the central range to the top range 

 
TWO DOWN The random cycling of scale TWO shifts from the central range to the bottom range 4

3
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B.6 TRACK State Change Entries 

Item # SCHED 
Event Type� Description 

 
TRACK MANUAL Starts a manual tracking session. In manual mode the subject uses the joystick to keep the 

target within the inner grid.  

 
TRACK AUTO Ends a manual tracking session.  The joystick is not polled for inputs and the target is 

automatically caged within the inner grid. 
2
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B.7 RATE State Change Entry 

Item # RATE 
Event Type� Description 

 
START The Workload Rating Scale questionnaire appears at a time of two minutes and thirty 

seconds. While the questionnaire is opened the elapsed timer is not updated.  The 
questionnaire will timeout if the subject does not complete the scales in the specified time.  

1

1
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C MATB Menu Operations 

Menus allow the user to make a selection to perform some action with MATB. The File and Help
selections are always available, while the Train and Test selections are only available if the 
appropriate mode is set to true in MATB_CONFIG.xml file. 

C.1 File & Help Menu Items 

Item # Menu Item Description 

 
File The available actions are dynamic based upon the mode and phase of operations 

 
Help Two static choices which display dialogs with information about MATB 

 
X Note that the Close(X) button in the title bar is disabled. MATB may not be ended by this 

method familiar to PC users.  See Appendix C.3 for more information.  
3
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C.2  File, Train, Test & Help Menu Items 

Item # Menu Item Description 

 
Test Menu is available only when Test mode set to true in MATB_CONFIG.xml 

 
Train Menu is available only when Train mode set to true in MATB_CONFIG.xml 

 
 When either Test or Train mode set to true in MATB_CONFIG.xml additional state data is 

displayed on the main form. It is always shown with a black foreground on a white 
background.  

3
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C.3  File -> Exit Menu Item 

Item # Menu Item Description 

 
Exit Terminates MATB. Shortcut key is Ctrl+X 

 
X Note that the Close(X) button in the title bar is disabled. MATB may not be ended by this 

method familiar to PC users. This eliminates the chance of a single key stroke / mouse click 
error ending a run prematurely.  

2

1

1
2
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C.4  File -> Start Menu Item 

Item # Menu Item Description 

 
Exit Terminates MATB. Shortcut key is Ctrl+X. 

 
Start First step to start MATB, if Auto Start mode is false in MATB_CONFIG.xml. If Auto Start 

mode is set to true then this menu selection is not available and once the Events file is 
read, the events start to be processed. During subject training it may be useful not to use 
Auto Start. The shortcut key to start the run is Ctrl+S. 

2

1

1 2
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C.5  File -> Start Dialog 

Item # Dialog Box Description 

 
Start Yes starts MATB, while No closes the dialog. 1

1
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C.6 Help Menu Items 

Item # Menu Item Description 

 
About Launches dialog with short statement about MATB  

 
Tasks Opens submenus to select from a set of  “in a Nutshell” dialog 

 
Version Launches dialog with version information 3
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C.7  Help -> About Dialog 

Item # Dialog Box Description 

 
OK A short statement to acknowledge the subjects role in MATB. Select OK to close the 

message box.  
1

1
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C.8 Help -> Tasks Menu Items 

�
�
�
� �

Item # Menu Item Description 

 
WRS Launches  the Workload Rating Scale  “in a Nutshell” dialog 

 
SCHED Launches  the Scheduling “in a Nutshell” dialog 

 
TRACK Launches  the Tracking task  “in a Nutshell” dialog 

 
COMM Launches  the Communications task  “in a Nutshell” dialog 

 
RESMAN Launches  the Resource Management task  “in a Nutshell” dialog 

 
SYSMON Launches  the System Management task  “in a Nutshell” dialog 6
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C.9 Help -> Tasks -> COMM Dialog 
�

�
�
�
�
�
�
�
�
�
�
�
�
�
�
�
�
�

� �

Item # Dialog Box Description 

 
OK A short description of the communications task. 

Select OK to close the message box.  

1

1
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C.10 Help -> Tasks -> WRS Dialog 
�

�
�
�
�
�

� �

Item # Dialog Box Description 

 
OK A short description of the Workload Rating Scale. 

Select OK to close the message box.  

1

1
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C.11 Help -> Tasks -> RESMAN Dialog 
�

�
�
�
�
�
�

� �

Item # Dialog Box Description 

 
OK A short description of the resource management task. 

Select OK to close the message box.  

1

1
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C.12 Help -> Tasks -> SCHED Dialog 
�
�

�
�
�
�
�
�

� �

Item # Dialog Box Description 

 
OK A short description of the scheduling look ahead. 

Select OK to close the message box.  

1

1
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C.13 Help -> Tasks -> SYSMON Dialog 
�

�
�
�
�
�
�

� �

Item # Dialog Box Description 

 
OK A short description of the system monitoring task. 

Select OK to close the message box.  

1

1
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C.14 Help -> Tasks -> TRACK Dialog 
�

�
�
�
�
�
�

� �

Item # Dialog Box Description 

 
OK A short description of the tracking task. 

Select OK to close the message box.  

1

1
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C.15 Help -> Version Dialog 

Item # Dialog Box Description 

 
OK Displays version number and date along the checksum of the build version.  This is 

important because audio, configuration and events files may be unique to a specific version. 
Additionally new features will be added to MATB over time. Select OK to close the message 
box. 

1

1
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C.16 Test -> All Menu Items 

Item # Menu Item Description 

 
Communication Displays the dialog used to play sample audio files. Tests that the MATB audio files may be 

used on the computer 

 
Resource 
Management 

Displays the dialog listing the pump flow and tank consumption rates used for the current 
run.   

 
Timeout Values Displays dialog listing the event timeout values in seconds used for the current run. 

 
Tracking Displays the dialog that shows the state of the attached joystick.  

 
View Eventlist Displays the list view of the time sequenced events loaded for the run.  

 
View Schedlist Displays the list views of the time sequenced communications and manual tracking sessions 

loaded for the run. 

 
Workload Rating Displays the Workload Rating Scale form, which can then be completed. 7

  6 

5

4

3

2

1

1

2

3

5

7 4

6



Appendix Page 42 

C.17 Test -> Communications Menu Items 

Item #  Item Description 

 
Other Ship Plays an audio file instructing an aircraft with a call sign other than NASA 504 to tune one of 

the four radios to a specific frequency. The subject ignores these instructions during actual 
runs.  

 
Own Ship Plays an audio file instructing NASA 504 to tune one of the four radios to a specific 

frequency. The subject would respond to this instruction during an actual run.  

 
Invalid File Test Trying to play an audio file not found in the Audio sub-folder displays a dialog to that effect. 

If properly constructed and tested, this dialog would be displayed during an actual run. 
3
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C.18  Test -> Resource Management Dialog  

Item #  Item Description 

 
Pump One Flow rate in units per minute when the pump is on and operational 

 
Pump Two Flow rate in units per minute when the pump is on and operational 

 
Pump Three Flow rate in units per minute when the pump is on and operational 

 
Pump Four Flow rate in units per minute when the pump is on and operational 

 
Pump Five Flow rate in units per minute when the pump is on and operational 

 
Pump Six Flow rate in units per minute when the pump is on and operational 

 
Pump Seven Flow rate in units per minute when the pump is on and operational 

 
Pump Eight Flow rate in units per minute when the pump is on and operational 

 
Tank A Consumption rate in units per minute provided the tank is not empty 

 
Tank B Consumption rate in units per minute provided the tank is not empty 

 
OK Close the dialog when finished by selecting the OK button.  11
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C.19 Test -> Tracking Dialog  

Item # Item Description 

 
X Axis A red foreground means the attached joystick is sending this signal to the computer. X & Y 

axis state data are the only inputs we read and only in manual mode. 

 
Y Axis A red foreground means the attached joystick is sending this signal to the computer. X & Y 

axis state data are the only inputs we read and only in manual mode. 

 
Multiple  A gray foreground means the attached joystick is not sending this signal to the computer. 

MATB does not use this state data. 

 
Multiple A red foreground means the attached joystick is sending this signal to the computer.  MATB 

does not use this state data. 

 
Exit 

Note that the Close(X) button in title bar is disabled in the Training mode. The dialog is 
closed with the Exit button. 5
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C.20 Test -> Timeouts Dialog  

Item #  Item Description 

 
Communications 
Task 

Timeout value is seconds. If the subject does not respond to the audio message within this 
time period, it is recorded and controls become unresponsive to input. 

 
System Monitoring 
- Lights 

Timeout value is seconds. If the subject does not respond to the change in light color within 
this time period, it is recorded.  Note lights and scales may have different timeout values. 

 
System Monitoring 
- Scales 

Timeout value is seconds. If the subject does not respond to the change in a scale 
movement within this time period, it is recorded. Note lights and scales may have different 
timeout values. 

 
Workload Rating Timeout value is seconds. If the subject does not complete and enter responses to the 

workload rating scale within this time period, it is recorded and the dialog closed. 

 
OK Closes the dialog when finished by selecting the OK button.  5
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C.21 Test -> View Events List  

Item #  Item Description 

 
ID Sequence number of this event. 

 
Start Time The start time of the event with respect to the run start time. The run timers may be paused, 

so event start time may not be in sync with clock time.  

 
Event Type Events may be COMM, CTRL, RESMAN, SCHED, SYSMON, TRACK or workload RATE. 

CTRL are control events, the others are tasks, task scheduling or workload rating 
questionnaire.  

 
Activity Start, Stop or End. 

 
Attribute Attribute type.  

 
Close Note that the Close(X) button in title bar is disabled in the Test mode. The dialog is closed 

with the Close button. 

 
Time The run elapsed time when the list is displayed. The runs stop while the event list is 

displayed. 
7

6

5

4

3

2

1

2

1

3

4

6
5

6 7



Appendix Page 47 

C.22 Test -> View Schedule List 

Item #  Item Description 

 
Communications Start and stop times of each session along with the duration of the session. Extracted from 

the events file. 

 
Tracking Start and stop times of each session along with the duration of the session. Extracted from 

the events file. 

 
Close Note that the Close(X) button in the title bar is disabled in the Test mode. The dialog is 

closed with the Close button 
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C.23 Test -> Workload Rating Scale 

Item #  Item Description 

 
Slider The value is selected by moving the slider to the desired position 

 
Value The actual value is shown with black foreground and a white background in Test Mode. It is 

not displayed in the normal mode.  

 
Reset The subject may reset all values to the initial conditions if desired 

 
Elapsed Time The number of seconds the subject has used in completing the questionnaire. Time is not 

displayed in normal mode. 

 
X Note that the Close(X) button in the title bar is disabled in the Test mode.  

 
Save All The results are recorded and the dialog closed with the Save All button 6

5

4

3

2

1

3

1

4 6

5

2



Appendix Page 49 

C.24 Train Menu Items 

Item # Menu Item Description 

 
Communication Displays the dialog used to play sample audio files.  Allows the subject to hear how each 

type of file sounds 

 
Workload Rating Displays the Workload Rating questionnaire, which can then be completed. 2

1

1
2



Appendix Page 50 

C.25 Train -> Communications Dialog 

Item # Menu Item Description 

 
Other Ship Selects an audio file instructing an aircraft with a call sign other than NASA 504 to tune one 

of the four radios to a specific frequency. The subject ignores these instructions during 
actual runs. File OTHER_TESTFILE.wav must be in the MATB Audio subfolder.  

 
Own Ship Selects an audio file instructing NASA 504 to tune one of the four radios to a specific 

frequency. The subject would respond to this instruction during an actual run.  File 
OWN_TESTFILE.wav must be in the MATB Audio subfolder. 

 
COM One Selects an audio file instructing the subject to tune the communications one radio to a 

specific frequency. File COM1_TESTFILE.wav must be in the MATB Audio subfolder. 

 
 

COM Two Selects an audio file instructing the subject to tune the communications two radio to a 
specific frequency. File COM2_TESTFILE.wav must be in the MATB Audio subfolder. 

 
 

NAV One Selects an audio file instructing the subject to tune the navigation one radio to a specific 
frequency. File NAV1_TESTFILE.wav must be in the MATB Audio subfolder. 

 
 

NAV Two Selects an audio file instructing the subject to tune the navigation two radio to a specific 
frequency. File NAV2_TESTFILE.wav must be in the MATB Audio subfolder. 

 
 

Play File Note that the Play File button is not always visible. Once an option is selected via a radio 
button, it becomes visible as shown on the right. 

 
 

Close 
Note that the Close(X) button in title bar is disabled in the Training mode. The dialog is 
closed with the Close button 8

7

6

5

4

3

2

1

7

8

8

8

7

7
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4
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C.26 Train -> Workload Rating 

Item #  Item Description 

 
Slider The value is selected by moving the slider to the desired position. 

 
Value The actual value is not displayed in Training Mode, as it is in Test Mode. It is not displayed 

in the normal mode.  

 
Reset The subject may reset all values to the initial conditions, if desired. 

 
Save All The Save All button is not displayed until all the sliders have been moved. Once the button 

is displayed the message is removed.  

 
X Note that the Close(X) button in title bar is enabled in the Training mode.  5

4

3

2

1

1

2

3 4

5
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D Communications Task 

The Communications (COMM) task is displayed in the lower left area of the MATB display.  The 
subject’s task is to change the frequency on one of four radios when the audio instruction is directed 
to our aircraft, which is “NASA 504”.  When the instruction is intended for another aircraft it is 
ignored.  The frequency is changed by selecting the radio button for the intended radio and then 
using the scroll bar pointers to the immediate right as needed. 
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D.1 COMM Initial State 

Item # Item Description 

 
Call Sign Our call sign is NASA504, 

which is the only call sign the 
subject responds to for radio 
frequency changes. 

 

NAV Radio  
Frequency� In the initial state both NAV 

radios are set to 112.500. 

 

COM Radio 
 Frequency� In the initial state both COM 

radios are set to 126.500. 
3

2

1

2

1

3
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D.2 COMM Session Initial State 

Item # Item Description 

 

 
COMM  
Session�

No COMM sessions have been 
processed yet 

 

 
TRACK 
Session�

For reference, no TRACK 
sessions have been processed 
yet either. 

 

 
Elapsed Time The run start event has not 

been processed. 
3

2

1

1

3

2
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D.3 COMM Session Start Event  

NOTE:  Sessions are in START-STOP pairs. There must be a corresponding STOP event in order 
for the session to be displayed on the Scheduler. See Appendix D.2 and D.4. 

D.4 COMM Session Started  

Item # Item Description 

 

 
COMM  
Session�

COMM session processed, and 
will be active for almost all of 
the 2 minute run. 

 

 
TRACK 
Session�

For reference, there are 
TRACK sessions scheduled for 
this run. 

 

 
Elapsed Time Four seconds into the run. 3

2

1

1 2

3
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D.5 COMM OWN COM1 Event 

NOTE:  The call sign for OWN ship is always NASA504.

D.6 COMM OWN COM1 Event Handled 

Item # Name Description 

 
COM1 Radio Button The instruction is for NASA504, 

so the subject should select the 
COM1 radio button 

 
COM2 Radio Button Since neither COM2 nor the 

NAV radios will be changed 
their radio buttons are not 
selected 

 
NAV1 Frequency Since NAV1 is not selected the 

frequency scrollbars are not 
available 

 
Ordinal-Scroll Bar The ordinal scrollbar allows the 

subject to  increment or 
decrement  the ordinal 
component  of the frequency 

 
Decimal-Scroll Bar The decimal scrollbar allows 

the subject to increment or 
decrement the decimal 
component of the frequency 

 
ENTER Button Once a radio button is selected 

the ENTER button becomes 
visible 

6

5

4

3

2

1

4

1
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D.7 COMM OWN COM1 Changed Entered 

Item # Item Description 

 

 
COM1 Radio Button Once the ENTER is selected 

and the frequency registered 
the radio button is unselected. 

 

 
COM1 Frequency The COM radio One frequency 

is now 124.575. 

 

 
ENTER Button Once selected the ENTER 

button is no longer visible. 
3

2

1

1 2

3
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D.8  COMM OTHER NAV2 Event 

NOTE:  The call sign for OTHER may be anything other than NASA504. A number of different call 
signs are used in the audio files provided on the distribution media. Examples are ACEY 5288 and 
CITRIS 211. “ACEY” is the call sign for Atlantic Southeast Airlines (ASA) and “CITRIS” is the 
call sign for Air Tran Airlines.

D.9  COMM OTHER COM2 Event Handled 

Item # Item Description 

 

 
COM2 Radio Button 

Since the instruction is not for  
NASA504 it is ignored and the 
radio button not selected

 

 
COM2 Frequency Since the radio button is not 

selected the scrollbars are not 
visible 

 

 
ENTER Button Nor is the ENTER button 

visible 
3

2

1

1 2

3



Appendix Page 59 

D.10 Output File Entries for COMM Events 

File: MATB_yyyy_mmddhhmm.txt entries 

                                                                                         
                            

                                                                                       

                                

 5 4  3 8  7  6  2 1
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Item # Event Task Description 

 

4 Event Processed: Scheduling Starts a Communications Session at a time of 00:00:10.  

 

6 Event Processed: Communications  Processed the first COMM event, which in this example is an OWN 
COM1 frequency change to 124.575, at a time of 00:00:15.  
 

 
 Subject Response: Communications 

Subject response to the above event, by selecting the COM1 radio 
at a time of 00:00:20.8. 

 
 Subject Response: Communications Subject response with a series of integer and decimal frequency 

changes. 

 
 Subject Response: Communications The subject registers the frequency change by pressing the 

ENTER button at a time of 00:00:27.0.  

 
9 Event Processed: Communications Processed the next COMM event, which in this example is an 

OTHER COM2 frequency change to 130.725, at a time of 
00:00:50. Since this is not for NASA504, this instruction should be 
ignored.  

 
13 Event Processed: Communications Processed another COMM event. This one is a NAV ONE OWN 

SHIP frequency change to 112.550. Note on the next line that the 
subject does not response to this event. 

 
 

Event Terminated: Communications  Both events 9 and 13 terminated without 
subject response. In the first this was the 
appropriate response but the  

 

Both events 9 and 13 terminated without subject response. In the 
first this was the appropriate response but the subject should have 
responded to event 13.  

 

 8 
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File: COMM_yyyy_mmddhhmm.txt entries 

                                                                          

                    
                                                        

Item # Item Description 

 
Run time of response Elapsed time to tenth of a second 

 
Reaction Time The number of seconds the subject takes to respond to the above 

event 

 
Target Ship OWN (NASA504) or OTHER from the audio file instruction 

utterance. 

 
Target Radio COM1, COM2, NAV1 or NAV2 from the audio file instruction 

utterance. 

 
Target Frequency Frequency from the audio file instruction utterance. 

 
Selected Radio COM1, COM2, NAV1, NAV2 or NULL if no radio is selected. When 

the instruction is targeted to OTHER, NULL is the correct 
responses.  

 
Selected Frequency When the instruction is targeted to OTHER, NULL is the correct 

responses. 

 
Correct Radio Selected Boolean result from a comparison of target and selected radio.   

When the target ship is OTHER and selected radio is NULL, the 
result is true. 

 
Correct Frequency Set Boolean result from a comparison of target and selected 

frequency.   When the target ship is OTHER and selected 
frequency is NULL, the result is true. 

 9 

 8 

 7 

 6 

 5 

 4 

3
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E Resource�Management�Task�

The Resource Management (RESMAN) task is displayed in the lower center and right of the MATB 
display.  The subject’s task is to maintain the fluid volume in tanks A and B in the indicated range 
through the use of one or more of the available eight pumps. In the normal state all the pumps are 
available provided the source tank is not empty. However in the non-normal state one or more of the 
pumps is inoperative. 
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E.1 RESMAN Event to Include Task 

NOTE:  Use “<task>RESSYS</task>” to start both RESMAN and SYSMON tasks with a single 
entry 

 



Appendix Page 64 

E.2 RESMAN Initial State 

Item # Item Description 

 
Fluid Volume Visual Indicator The GREEN bar shows the current fluid level in the tank. The initial 

level is 2500 units for both tanks A and B with the consumption 
beginning as soon as the RESMAN-START event is processed 
(see Appendix E.1 above). 

 
Fluid Volume Numeric Indicator  When the volume is within the desired 2000 to 3000 range the 

value is displayed in blue. If above or below the value is RED. 

 
Pump number, direction and state This is the ON/OFF switch for pump ONE, which initially is OFF. 

The caret shows that the pump source is tank C and the 
destination is tank A. When a pump in ON it is colored GREEN and 
the background color when OFF. All eight pumps operate the 
same. 

 
Pump Rate Numeric Indicator Indicates the current rate for pump number one. When the pump is 

off or inoperative the rate will show a flow rate of 0 units per 
minute. When a pump is ON the preset flow rate will be shown. 
Both the consumption rates of tanks A & B and the flow rate of 
each of the pumps is configurable. 

 
Target Range Indicator The light blue shaded blocks indicate the desired range for tank A 

and B volume, which is 2000 to 3000 units.  

 
Fluid Volume Visual Indicator The initial volume of tank D is 1000 units. Pump 3 transfers fluid 

out and pump 6 transfers fluid in. Tank C works the same, but with 
pumps 1 and 5.  

 
Tank E & F These two tanks are unlimited sources for the other four tanks.   7 

 6 

 5 

 4 
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E.3 RESMAN Selected Pumps Activated By User 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

Item # Item Description 

 
Pump  One The GREEN background indicates that the subject turned pump ONE ON. 

The flow rate for pump ONE is 800 units per minute.  

 
Pump Two The GREEN background indicates that the subject turned pump TWO ON. 

 
Pump Three The GREEN background indicates that the subject turned pump THREE ON. 

 
Pump Four The lack of a distinctive color background indicates that pump FOUR is OFF, which is 

verified by a 0 units per minute flow rate. 

 
Pump Five The GREEN background indicates that the subject turned pump FIVE ON. 

 
Pump Six The GREEN background indicates that the subject turned pump SIX ON. 

 
Pump Seven The lack of a distinctive background color indicates that pump SEVEN is OFF. 

 
Pump Eight The lack of a distinctive background color indicates that pump EIGHT is OFF.  8 

 7 
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E.4 RESMAN Event to Fail a Pump 

 

NOTE:  “P1” represents pump one.  
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E.5 RESMAN Pump ONE Failed 

 
  

Item # Item Description 

 
Pump  One The RED background indicates that pump ONE has failed as the result of the event being 

processed. 

 
Pump  Five The GREEN background indicates that the subject turned the pump ON. 

Only a single pump is affected by an event, which in this case was pump ONE.  

 
Flow Rate Since pump ONE failed, the flow rate is 0 units per minute. 

 
Flow Rate Since pump FIVE is on, the flow rate remains at 600 units per minute.  4 
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E.6 RESMAN Event to Fix a Pump 

 

NOTE:  “P1” represents pump one.  
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E.7 RESMAN Pump ONE Fixed 

Item # Item Description 

 
Pump  One When fixed, a pump returns to the initial state, which is OFF, no matter what state it was in 

when it failed. 

 
Pump Five The GREEN background indicates that pump FIVE is still ON. 

 
Flow Rate The flow rate of pump ONE is 0, since when fixed it returns to the initial state which is OFF. 

 
Flow Rate Since pump FIVE is still on, the flow rate remains at 600 units per minute.  4 

3
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E.8 Output File Entries for RESMAN Events

File: MATB_yyyy_mmddhhmm.txt entries 

                       

Item # Event Action Description 

 
1 Event Processed: Scheduling The Resource Management task is active. Tank A and B 

consumption begins. 

 
2 Subject Responses: Resource 

Management 
Pumps ONE and TWO turned ON at times of 00:00:2.3 and 
00:00:03.1. 

 
 Event Processed: Resource Management RESMAN event processed. Pump ONE was failed. 

 
3 Subject Responses: Resource 

Management 
Pumps FIVE, SIX, THREE, and FOUR all turned on by the subject. 

 
5 Event Processed: Resource Management RESMAN event processed.  Pump ONE was fixed. 

543 2 1

 5 

 4 

3

2

1
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File: RESMAN_yyyy_mmddhhmm.txt entries 

                                                                                                       

                                                                                                     

Item # Item Description 

 
Run time of response Elapsed time to tenth of a second 

 
Pump Number Pump ONE turned on. 

 
 

Pump Action “On” and “Off” are user responses 

“Fail” and “Fix” are the result of event processing 

 
Tank Update “N” (NO) when the tank volumes are being recorded due to a event 

or user actions, and “Y” (YES) when triggered by the recording 
interval timer 

 
Tank A Volume 2471 units at a time of 00:00:04.0 when Pump FIVE is turned ON. 

 
Tank B Volume 2642 units as recorded when triggered by a time interval, 

00:00:30.0 

 
Tank C Volume 987 units when pump ONE failed at a time of 00:00:03.5 

 
Tank D Volume 1000 units when pump 6 was turned on 

 
Tank A Differential from the initial condition -122 (2378 - 2500) at time 00.00.35.5. 

 
Tank B Differential from the initial condition 2032 (2707 – 2500) at time 00.00.35.5. 

1098765 4 321
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F System Monitoring Task 

The System Monitoring (SYSMON) task is displayed in the upper left of the MATB display.  The 
subject’s task is to return the two lights and four scales to the normal position as soon as it is noticed 
that they are in a non-normal state. The GREEN light is normally ON with OFF as the non-normal 
state.  The RED light is normally OFF with ON as the non-normal state. The positions of four scales 
update randomly around the center in the normal state and either shift to the top or bottom regions of 
the scale in the non-normal state.  
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F.1 SYSMON Initial State 

Item # Name Description 

 
Light Normally On GREEN is the initial state of 

this light.  

 
Light Normally Off In the initial state the color of 

this light is the same as the rest 
of the MATB background  

 
Scale One of Four When inactive the background 

color of the scales is light blue. 
3

2

1

1 2

3
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F.2 SYSMON Event to Activate the Normal State 

NOTE:  Use “<task>RESSYS</task>” to start both RESMAN and SYSMON tasks with a single 
entry.
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F.3  SYSMON Normal State 

F.4 SYSMON Event to Turn the GREEN Light OFF 

Item # Name Description 

 
Light Normally On In the normal state the color of 

this light is GREEN. 

 
Light Normally Off In the normal state the 

background color of this light is 
the same as the rest of the 
MATB background.  

 
Scale One of Four When active the foreground 

color of the scales is a dark 
blue with a yellow “right sift 
operator” sign in the center 
segment. The position of each 
is continuously randomly 
updated independently. 

3

2

1
1 2

3
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F.5 SYSMON GREEN Light OFF Event 

F.6 SYSMON Event to Turn the RED Light ON 

Item # Name Description 

 
Light Normally On When a GREEN light event is 

processed color of this light 
becomes the same as the rest 
of MATB’s background. 

 
Light Normally Off This light remains in the normal 

state. 

 
Scale One of Four The scales remain in the 

normal state. 
3

2

1

1 2

3



Appendix Page 77 

F.7 SYSMON RED Light ON Event 

�

F.8 SYSMON Event to Move Scale Two DOWN

Item # Name Description 

 
Light Normally On This light remains in the normal 

state. 

 
Light Normally Off When a RED light event is 

processed the background 
color of this light becomes 
RED. 

 
Scale One of Four The scales remain in the 

normal state. 
3

2
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F.9  SYSMON Scale Two DOWN UP 

F.10    SYSMON Event to Move Scale Three UP 

Item # Name Description 

 
Light Normally On This light remains in the normal 

state. 

 
Light Normally Off This light remains in the normal 

state. 

 
Scale Two of Four Scale two indicator moves 

below the normal range. The 
other scales remain in the 
normal state and the position of 
each is independently and 
continuously updated. 

3

2

11 2

3
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F.11  SYSMON Scale Three UP�

Item Name Description 

 
Light Normally On This light remains in the normal 

state. 

 
Light Normally Off This light remains in the normal 

state. 

 
Scale Four of Four Scale three indicator moves 

above the normal range. The 
other scales remain in the 
normal state and the position of 
each is independently and 
continuously updated. 

3

2

1

1 2

3
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F.12 SYSMON Return to the Normal State 

The SYSMON task returns to the normal state by clicking with the mouse on the appropriate light or 
scale, or selecting the appropriate function key (e.g. F1 or Scale One, and F6 for the light normally 
off). 

SYSMON will also return to the normal state when the event timeout value is reached before the 
appropriate response is made.  
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F.13  Output File Entries for SYSMON Events 

File: MATB_yyyy_mmddhhmm.txt entries 

                                                                                          
                                                            

Item # Event Task Description 

 
6 Event Processed: System Monitoring Processed the first SYSMON event, which in this example is a 

GREEN light off at a time of 00:00:10.0 

 
 Subject Response: System Monitoring The GREEN light is turned back on at a time of 00:00:12.9 

 
8 Event Processed: System Monitoring Scale TWO processed at  00:00:28.0 

 
 Subject Response: System Monitoring The Scale TWO is returned to the normal state on at a time of 

00:00:29.7 

 
20 Event Processed: System Monitoring Scale ONE processed at  00:01:43.0 

 
 Event Terminated: System Monitoring Subject failed to respond to the above event within the allowed 

time limit. 
 6 

 5 

 4 

3

2

1
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File: SYSM_yyyy_mmddhhmm.txt entries 

                                                                                                               
                                                            

Item # Item Description 

 
Run time of response Elapsed time to tenth of a second 

 
Elapsed time since event processed Event processed at 00:10.0 with response at 00:12.9, which equals 

a 02.9 second response time. 

 
Light system processed Light event processed. 

 
Subject response  Subject responded by attempting to turn the GREEN light ON. 

 
Was this the correct response? Yes, this was a GREEN light turned OFF event so True for the 

desired response. 

 
Was this the correct response? Yes, this was a RED light turned ON event so TRUE for the 

desired response. 

 
Event Timedout The SCALE One event processed at a time 01:43.0 was not 

correctly responded to in the 10 second timeout window, so -10 
response time recorded with the appropriate remark that the 
“Event Timedout”. 

 7 
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G Tracking�Task�

The Tracking (TRACK) task is displayed in the top center of the MATB display.  The subject’s task 
is to keep the target in the center of the grid, when the task is in manual mode.  When the task is in 
automatic mode (i.e. autopilot) no action is required by the subject. The current mode is displayed in 
a text box below and to the right of the grid.
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G.1 TRACK Initial State 

Item # Item Description 

 
The Target In manual mode the subject uses the joystick to keep the target 

centered on the crosshairs. 

 

 
Grid The track grid lines are a light blue See appendix G.4 for color 

change during “Manual” mode.  

 

 
Mode indicator In automatic mode MATB controls the target. 

 

 
Elapsed Time Four seconds after the run started 

 

 
Communication Session There is one communications session during this run. 

 

 
Run End Time The RED “T” provides a visual cue that this run is two minutes 

long. 

 

 
Tracking Sessions No tracking sessions are scheduled for this run. 7

6

5

4

3

2

1

3 4

7
1

2

5

6



Appendix Page 85 

G.2 TRACK Session Schedule  

Item # Item Description 

 
Mode indicator In automatic mode, MATB controls the target. 

 

 
Tracking Session First manual mode session is about to start and lasts for 45 

seconds. 

 

 
Tracking Session After 20 seconds in automatic mode the second manual 

session begins a little more than a minute from now. 

 

 
Tracking Session After returning to automatic mode, there is a third manual 

session, which is much shorter than the others in this run.  

 

 
Tracking Session The last manual mode session starts about two and one half 

minutes from now. 

 

 
Run End Time The RED “T” provides a visual cue that this run is three 

minutes long. 
6
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G.3 TRACK Session Manual Event  

Item # Item Description 

 
Event startTime Five seconds into the run 

 

 
Action Manual mode. The subject controls the position of the target 

with the joystick. 

 

 
Update Amount of random target movement per update cycle.  

 

 
Response Amount of influence the joystick has on target movement per 

update cycle. 
4
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G.4 TRACK Manual Session Started  

 

Item # Item Description 

 
Manual mode. The subject controls the position of the target with the joystick. 

 

 
TRACK Task Manual The track task is active whenever the GREEN bar is visible. 

 

 
TRACK Task Automatic There is a 30 automatic mode segment before the second 

manual session starts.  

 

 
Run end time The RED “T” indicates the end of the run. Here a little less 

than three minutes from now. 

 

 
Grid The track grid lines are a dark blue. See the appendix for color 

changes during “Auto” mode. 
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G.5 TRACK Manual Session – Target Drift 

Note the location of the target in the northwest quadrant.

G.6 TRACK Manual Session – Target Caged 

Now note the location of the target in the northwest quadrant. When the target is off the grid, its 
outer ring is drawn in ORANGE with the center shown at the point of departure. 
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G.7 TRACK Manual Session – Target Controlled 

The subject is now influencing the position of the target with the joystick. The task is to keep the 
target in the center of the grid.  
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G.8 TRACK Session Auto Event  

Item # Item Description 

 
Event startTime Fifty seconds into the run 

 

 
Action Automatic mode. The autopilot controls the position of the 

target. 

 

 
Update / Response Target update and joystick responses are not used in auto 

mode. 
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G.9 Output File Entries for TRACK Events

File: MATB_yyyy_mmddhhmm.txt entries 

Item #  Event  Action  Description  

 
 

Device Initialization  A joystick is required for the tracking task. If one is not detected, a 
dialog is displayed and the task is not shown.  

 

3/15  Event Processed: Scheduling  Manual Tracking session started.  

 

10/21  Event Processed : Scheduling  Manual Tracking session ends and automatic mode resumes.  

 
 

Recording Interval Triggered: Tracking  For this run, the tracking task recording interval is 15 seconds. The 
event processed at a run time of “0:08.0” records for the first time 
at a time of �23.0” seconds.  
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File: TRCK_yyyy_mmddhhmm.txt entries 

                                                                                                     

Sampling data is stored in three different sets of registers; the first is reset at the end of each interval, the 
second at the end of each session and the third is updated without resetting for the entire run. This allows 
different views of the subject’s response. 

Item # Action Description 

 
Elapsed Time   

 
Session Time  

 
Number of samples The target position is sampled every 50 ms while in manual mode 

and recorded at 15 second intervals (the interval is configurable).  
Depending upon overall MATB activity the number of samples will 
vary slightly. 

 
Sum Of Squares Sum of Squares of each target position offset from the center.  

 
RMSD-C The Root Mean Square Deviation from the Center Point in Pixel 

Units. Compare the values for the second and seventh entry. 

 
Remarks Records the target update and joystick response fidelities for the 

session. Note that these are set for each session, so multiple 
combinations may be used during a single run. 

 
Recording Interval The recording interval is set in MATB_Config.xml 

654321
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H Workload Rating Scale 

The Workload Rating Scale (WRS) provides a method to obtain a subject’s assessment of 
their workload during task performance. The Workload Rating questionnaire is launched 
by the appropriate entry in the task events file. While the rating scale is presented the run 
timer is paused. Active events in progress when the rating scale appears will not time out 
nor will any new events be processed until the timer is resumed.  The rating scale used is 
based on the NASA Task Load Index (NASA TLX).  The subscales are: Mental Demand, 
Physical Demand, Temporal Demand, Own Performance, Effort and Frustration.  Each 
subscale has a slider for selecting a value. Once all the sliders have been moved the 
“Save All” becomes visible. 

While the mouse is the primary way to respond to the WRS, the user may elect to use the 
arrow keys. The form opens with the focus on the first questions (i.e. Mental Demand). 
The right and left arrow keys are used to move the cursor. The up and down arrow keys 
move between the questions. Selecting the down arrow key from the last question (i.e. 
Frustration) moves the user to the “Save All” button, provided each of the sliders has 
been moved. 
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H.1 WRS Event to Launch the Questionnaire 

Sample events file entries that launch the Workload Rating Scale (WRS) questionnaire. The entry 
stops the elapsed timer and displays the WRS questionnaire. 

Item # Action Description 

 
<wrs> is the element key name Elapsed timer is stopped and questionnaire displayed at a time of 

0:00:05 

 
<wrs> is the element key name Elapsed timer is stopped and questionnaire displayed again at a 

time of 0:00:20 
2
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1
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H.2 WRS Initial Display State 

�
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H.3 WRS Completed Display State (Example) 
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H.4 Output File Entries for WRS Events

File: MATB_yyyy_mmddhhmm.txt entries 

Item # Event Action Description 

 
1 Control Starts Run 

 
3/4 Event Processed: Workload Rating Scale Launches the WRS questionnaire 

 
5 Control Ends Run 3
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File: WRS_yyyy_mmddhhmm.txt entries 

                                                       

Item # Action Description 

 
Elapsed Time  For the first instance the workload rating event was processed 14 

seconds into the run. 

 
Session Time For the same instance the subject spent a little more than 23 

seconds to complete the questionnaire. 

 
MENL The mental demand score 

 
PHYS The physical demand score 

 
TEMP The temporal demand score 

 
PERF Own performance score 

 
EFFT Effort score 

 
FRUS Frustration score 

 
MEAN The sum of the six scores divided by six.  9 

 8 

 7 

 6 

 5 

 4 

3

2

1

987654321
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I Recording Interval Output File Entries 

At regular time intervals determined during configuration, MATB-II records output 
relating to processed events and subject responses. The entries are made for the 
RESMAN and TRACK task in their output files (i.e. TRCK_yyyy_mmddhhmm.txt and 
RMAN_yyyy-mmddhhmm.txt). In addition, an entry is made to 
MATB_yyyy_mmddhhmm.txt whenever one of these is triggered.  

Note: See the “Recording Interval” subsection in the “MATB Configuration File” section 
for information on how to set these values.
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I.1 Output File Entries for Joystick Device 

The Tracking (TRACK) task requires a Universal Serial Bus (USB) joystick be attached 
to the computer. One of the MATB-II initialization steps is to poll the attached devices 
for the presence of a joystick. The first entry in every MATB_yyyy_mmddhhmm.txt is 
joystick status.
Note: As the TRACK task is not required for a valid run, the user may elect to continue 
without the use of a joystick.�

File: MATB_yyyy_mmddhhmm.txt entries 

��
�
�

�
�
�
�
�
�

�
�
�
�

� �

Item # Action Description 

 
Device Initialization A USB  joystick was found when the attached devices were polled. 

 
Device Initialization No USB  joystick was found when the attached devices were 

polled. 
2

1

1

2
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I.2 Output File Entries for TRACK Task Interval Recordings 

File: MATB_yyyy_mmddhhmm.txt entries 

File: TRCK_yyyy_mmddhhmm.txt entries, shown in a figure that has been split in two parts. 

Item # Action Description 

 
Recording Interval Triggered: Tracking Second trigger for the first manual mode session of this run 

 

 
Recording Interval Triggered: Tracking First trigger for the second manual mode session of this run. Note 

that on the initial trigger the target update and joystick response 
rates are recorded in the remarks column. 

 
Recording Interval: 15 seconds Since this is a configurable item, the run value is recorded in the 

header of the TRACK task output file. 
3

2

1

2

1

2

3

1

2
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I.3 Output File Entries for RESMAN Task Interval Recordings 

File: MATB_yyyy_mmddhhmm.txt entries 

File: RMAN_yyyy_mmddhhmm.txt entries 

� �

Item # Action Description 

 
Recording Interval: 20 seconds Recording starts at 20 seconds into the run and continues at 20 

second intervals thereafter. 

Since this is a configurable item, the run value is recorded in the 
header of the RESMAN task output file. 

 
Recording Interval Triggered: Resource 
Management 

The Action is recorded in MATB_yyyy_mmddhhmm.txt, with the 
tank volumes and differentials in RMAN_yyyy_mmddhhmm.txt. 

2

1

1

2

2 2

1
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I.4 Lost Focus and Run Paused Output File Entries 

MATB-II records an entry whenever the run elapsed timer is stopped. There are two 
actions which cause the run elapsed timer to stop. One of the actions occurs when the 
user selects another application (e.g. a document or desktop shortcut, etc) and the other, 
when the user pauses the run with either the Menu -> Pause item or Ctrl-P key pair. The 
user can pause/resume MATB-II only when the AUTO_SELECT_MODE configuration 
key is “false”.  The entries are made once the run elapsed timer is restarted.

Note: For best performance, MATB-II should be the only application open during a data 
collection run, and the AUTO_SELECT_MODE configuration key is intended to be set 
to “true”. During scenario development and subject training, it may be advantageous to 
have the User’s Guide or other documents opened and minimized and / or 
AUTO_SELECT_MODE configuration key set to “false”. 

File: MATB_yyyy_mmddhhmm.txt entries 

Item # Action Description 

 
Information: MATB Lost The Focus The time the focus was lost is recorded in the remarks column. In 

this instance it was for 7.4 seconds 

 
Information: MATB Was Paused By The 
User  

The time the run was paused is recorded in the remarks column. In 
this instance it was for 12.3 seconds 

2

1

1

2
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J Error and Warning Messages 

MATB-II performs a number of checks and provides messages to the user when 
appropriate.  They are intended as an aide during scenario development. “Warning” 
messages allow the run to continue, but MATB-II will shut down after an “Error” 
message is displayed. Neither “Error” nor “Warning” are appropriate during data 
collection runs.

MATB-II initialization requires a configuration file. The default filename is 
MATB_CONFIG.xml. If the file is not found in the XML subfolder, a message is shown 
and MATB will shut down.  

While a joystick must be installed to use the TRACK task, MATB may be used with only 
a subset of the available tasks.  If a joystick is not found a message is displayed.

On startup, MATB reads the events file and creates a sequenced list. MATB allows 
multiple events to occur at the same time, but will reject an event with a time stamp 
earlier than the last one processed. If one is detected a message is displayed to the user. 

The COMM and TRACK tasks are scheduled in “start” and “stop” sessions, which are 
visible on the Scheduling section of the display.  “Start-Stop” event pairs are required to 
bracket each session. If one of these is missing a message is displayed and the desired 
session is not visible on the SCHEDULING display area.

The MATB installation media includes eight sets of 80 different audio files for use with 
the COMM task. These sets are in subfolders of the Audio directory named 
FEMALE_VOICE_SET_1, FEMALE_VOICE_ SET_2, MALE_VOICE_ SET_1, 
MALE_VOICE_ SET_2, MIXED_SET_1, MIXED_SET_2, MIXED_SET_3, and 
MIXED_SET_4. The first four folders contain the sound recordings of one individual and 
the other four are a mix of each of these sets. The MATB setup application 
(SetupMATBII.msi) installs the SET_1 files in the “\MATB\Audio” subfolder. These 
files are the utterances corresponding to the COMM events.  If the sound recording 
corresponding to the COMM event is not found in the “\Audio” subfolder a message is 
displayed and the processed event ignored. The MATB run will continue.  
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J.1 Error Message – Configuration File Not Found 

If the configuration file is not found, MATB-II will shut down after a countdown timer expires. Make 
sure that MATB_CONFIG.xml is located in the XML subfolder. NOTE: Check that the file was not 
inadvertently saved without a file extension or with a “.txt” file extension instead of “.xml”. 

Note: Whenever MATB-II detects an error during initialization which prohibits normal operation, a 
timed message is displayed and MATB-II shuts down after the countdown timer expires. The error 
must be corrected to proceed past this point.  
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J.2 Error Message – Event Start Time Sequence Error 

When the start time of an event is earlier than the start time of the event which precedes it, further 
checking stops and this message box is displayed. There may be additional time sequence issues, so 
when the correction is made all the start times should be checked.  

Note: Whenever MATB-II detects an error during initialization which prohibits normal operation, a 
timed message is displayed box and then MATB-II shuts down after the countdown timer expires. 
The error must be corrected to proceed past this point. 
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J.3 Error Message – Scheduling Pairs Errors 

In order to be shown on the Scheduling “Look Ahead” window, COMM and TRACK sessions must 
be included in an events file. Both the COMM and TRACK sessions have “start” event, for which 
there must be and “stop” event. 

Note: Whenever MATB-II detects an error during initialization which prohibits normal operation, a 
timed message is displayed box and then MATB-II shuts down after the countdown timer expires. 
The error must be corrected to proceed past this point. 
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J.4 Error Message – Maximum Run Length Exceeded 

The maximum MATB-II run length is two hours.  In this example, the time was entered 
as 5 hours. While the intent may have been to create a 5 or 50 minute run, MATB-II does 
not allows runs longer than two hours.

Note: Whenever MATB-II detects an error during initialization which prohibits normal 
operation, a timed message is displayed and then MATB-II shuts down after the 
countdown timer expires. The error must be corrected to proceed past this point. 
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J.5 Error Message – Required Control Event Missing  

The first event MATB-II looks for is a control “START” event and the last must be a 
control “END” event. These set the boundaries between which MATB will check for 
events to process. 

Note: Whenever MATB-II detects an error during initialization which prohibits 
normal operation, a timed message is displayed and then MATB-II shuts down after 
the countdown timer expires. The error must be corrected to proceed past this point. 
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J.6 Warning Message – No Joystick Found 

When the user selects “OK”, MATB will continue, because there is no requirement that every task be 
included in a run. Selecting “Cancel” closes MATB. If the TRACK task is desired, ensure the joystick 
is properly connected.

MATB will continue without the tracking task grid or text box visible.  
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J.7 Warning Message – COMM Audio File Not Found 

MATB-II will continue once the “OK” is selected. Valid COMM events will be processed, but both 
the contents of the Audio subfolder and the entries in the events file should be inspected before the 
file is used again.
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J.8 Information Message – Timestamp Already Used 

In addition to the information messages initiated from the menu, MATB displays a message when a 
set of output files with the same timestamp already exist. This state occurs if MATB is restarted 
within the same minute as the previous instance. While this is not a common occurrence, it may 
happen when MATB closes automatically due to an issue with the selected events file (see the error 
message examples above) and the user immediately restarts the application, perhaps using a different 
events file.
The previously existing files are renamed with a “-1” appended to the filename and the run continues 
once the “OK” is selected. The MATB master file is shown in the examples below, but the same 
process applies to all the output data files. 

File: MATB_2011_01171144-1.txt

Item # Action Description 

 
Timestamp The timestamp used for all three files is 2011_01171144 

 
File creation time for the initial file Time of 11:44:11. This file renamed to MATB_2011_01171144-

1.txt when the second set is created. 

 
File creation time for the second file (see 
next page) 

Time of 11:44:20. This file renamed to MATB_2011_01171144-
2.txt when the third set is created.  

 
File creation time for the second file (see 
next page) 

Time of 11:44:43.  Filename is  MATB_2011_01171144.txt 4

3

2

1

12
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File: MATB_2011_01171144-2.txt

File: MATB_2011_01171144.txt

3 1

14
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K MATB-II Microsoft Compiled HTML Help 

MATB_Documentation.chm is Microsoft Compiled HTML Help File created with 
Sandcastle IntelliSense.  It provides the user information about the syntax, methods, 
properties and remarks of the source code.  MATB_Documentation.chm is located in 
the “\Help” subfolder.  In testing mode it may also be launched by selecting the “?” from 
the title bar.  
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L User Guide for Creating Events Files 
Through the generation of events, the researcher creates the experimental scenarios to which the 
subjects are going to respond to during a MATB-II session.  Events are managed through entries in 
an Extensible Markup Language (XML) file.  The purpose of this guide is to assist the experimenter 
to create these XML files.  The MATB description, installation procedures, subject and experimenter 
interfaces, and audio file creation are covered in other sections of this document.  

The naming convention for the events files is MATB_EVENTS-xxxx .xml, where “xxxx” is user 
defined. The name of the default events file is MATB_EVENTS.xml.  The experimenter may either 
use the default name or add a dash (i.e. MATB_EVENTS-) and append an identifying string as a 
suffix. The experimenter can choose any suffix  he/she desires, as long as this suffix doesn’t contain 
any character usually reserved for the Operating System of the computer, such as “\”. It is a good 
practice to select names that are meaningful to the experimenter to facilitate future retrieval; for 
example MATB_EVENTS-20min.xml is the events file for a run that lasts 20 minutes.  

There are six different types of MATB events: four that correspond to the tasks the subject responds 
to (COMM, RESMAN, TRACK and SYSMON), WRS which asks for subject for feedback, and 
SCHED which provides visual cues to the current and look-ahead state of the COMM and TRACK 
tasks.  Once started, the RESMAN and SYSMON tasks are always active unless explicitly stopped. 
In addition to the file entries that manage the events, there are additional entries that control the 
START and END of the run. 

This guide consists of a number of tools to assist the experimenter in creating events files. The first 
is a series of worksheets to document the general information and a sequential listing of the events. 
Once a listing is created, the creator opens the appropriate templates in a text editor and can copy 
and paste the required entries into the events file. Any simple text editor (e.g. Notepad) will work, 
although it is best to use one that recognizes and highlights XML syntax. For this reason, the 
freeware Crimson Editor 3.70 is provided on the MATB distribution.  Additionally a copy of 
Microsoft freeware XML Notepad 2007 is also provided on the MATB distribution. Those 
applications are useful for checking both the sequence and format of the events file when finally 
saved in the editor. While MATB performs some simple checks when it reads in the events file, only 
the creator knows the experiment objective. Refer to the Appendix for screen captures of Crimson 
Editor and XML Notepad 2007.  Note that XML Notepad 2007requires .NET Framework 2.0 to be 
installed on the computer. If you intend to create events files on a different computer, install “.NET 
Framework 2.0” before you install XML Notepad 2007.  A current version of the .NET Framework 
can be downloaded from http://msdn.microsoft.com.
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L.1  Using Worksheets and Templates 

A number of XML templates (MATB_EVENTS-template-xxx.xml) are provided with samples of the 
format used to control the events. They are provided so that the experimenter may copy the 
appropriate entries, paste them into their working file and then edit as needed.  The creator should 
initially “save as” the MATB_EVENTS-template-all.xml file renamed as appropriate before making 
changes to the file. This is easily done by opening up all the templates of interest in Crimson Editor, 
although the effect is possible by copying the entries from one or more of the appendices in this 
document.  

A worksheet is provided to assist the experimenter document at a high level the tasks desired to 
evaluate, their number of occurrences, and the duration of each run.  A cross-reference between tasks 
and the applicable template is listed at the end of this appendix. Usually a run will include all of the 
tasks, but this is not required.

The worksheet is provided for listing and sequencing by start time all the events to be included in the 
events file. Sample entries for this worksheet are listed by task in the Appendix. 

As previously noted, you can copy and paste directly from these appendices, although the 
recommended procedure is to open all the templates in Crimson Editor or the text editor of choice 
and then copy the desired entries and paste them in to the events file being created. Be sure to edit 
the entries as appropriate.

The Appendix also lists the names of the prerecorded audio files contained on the distribution media. 
Audio files must reside in the MATB\Audio subfolder for MATB to play them. Refer to the 
Appendix for the COMM task events file format.  
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L.2 Creating an Events File Step By Step  

1)  Print out a copy of the worksheet to document the sequence of the run.  

2)  Note which tasks will be used and the number of instances of each. Record the total duration of 
the run, as this is the first item you enter in the events file.

3) Open MATB_EVENTS-template-start.xml in the text editor (Crimson Editor or one of choice) 
and save with the appropriate name using the format MATB_EVENTS-xxxx.xml where the “xxxx” 
is an identifier assigned by the creator. This identifier should be unique for each events file, as it 
avoids duplication and can provide a special meaning to the creator.  Refer to the Appendix for a 
screen capture of Crimson Editor with open events files and templates. 

Using the completed event worksheet as a guide, copy each entry from the appropriate template file, 
paste in sequence in the new events file and edit the start time and tag values as needed.

Verify that the file is well-formed by opening it with XML Editor in Internet Explorer and view with 
Microsoft XML Notepad 2007 (XN07). When using XN07 you must expand the structure to see the 
child elements and their values. This is done from the menu bar by selecting View > Expand All.
Refer to the Appendix for a screen capture of XN07 with the child elements expanded. 

Copy the file to the MATB\XML subfolder, and test by running MATB-II.exe.
Note: In order to select events file with other than the default name of MATB_EVENTS.xml, the 
value of the <SELECT_EVENTSFILE_MODE> child element value must be “true” in the 
MATB_CONFIG.xml file. All the MATB_EVENTS-template-xxxx.xml files included with the 
distribution are valid files and may be used by MATB.  
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L.3  Experiment Worksheet 
Experiment Name:  
Objective:  
Estimated time for each run:  
Number of runs per subject:  
Tasks included in this run and 
the desired number of each 
type of event. 

COMM: Y       N # COMM:  
WRS: Y       N # WRS:  
RESMAN Y       N # RESMAN:  
SCHED: Y       N # SCHED:  
SYSMON: Y       N # SYSMON:  
TRACK: Y       N # TRACK:  

Use the Event Worksheet to sequence the list of events 
All runs begin with MATB_EVENTS-template-start.xml saved with a unique name.  
The SCHED task is always included; refer to MATB_EVENTS-template-sched.xml for sample 
entries. 
If COMM task is included, refer to MATB_EVENTS-template-comm.xml for sample entries. 
If WRS task is included, refer to MATB_EVENTS-template-start.xml for a sample entry, Appendix 
L.10
If RESMAN task is included, refer to MATB_EVENTS-template-resman.xml for sample entries. 
If SYSMON task is included, refer to MATB_EVENTS-template-sysmon.xml for sample entries. 
If TRACK task is included, refer to MATB_EVENTS-template-track.xml for sample entries. 
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L.4  Events Worksheet 

# Start Time Type Attribute Value 
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L.5  Sample Events Worksheet Entries for a COMM Event 
# Start Time Type Attribute Value 

1 0:02:20 COMM <ship> OTHER 
   <radio> COM1 
   <freq>  
     
2 0:08:40 COMM <ship> OTHER 
   <radio> NAV2 
   <freq>  
     
3 0:16:15 COMM <ship> OWN 
   <radio> COM2 
   <freq>  
     
4 0:32:25 COMM <ship> OWN 
   <radio> NAV1 
   <freq>  
     
  COMM <ship>  
   <radio>  
   <freq>  
Use the last entry above as a template to populate the Event Worksheet and the others as samples.
The MATB_AudioScriptsWithFilenames section provides guides and protocol to create additional 
audio scripts, the audio file naming convention and format to play these audio files in MATB-II.  Refer 
to the MATB_AudioScriptsWithFilenames in Appendix Q.    

L.6 Sample Events Worksheet Entries for a Workload Rating Scale 
(WRS) Event 

# Start Time Type Attribute Value 
1 0:04:15 WRS <wrs> START 
     
2 0:12:20 WRS <wrs> START 
     
At least one WRS event will be included in each run.  An example for a WRS entry is shown in  
MATB_EVENTS-template-start.xml, Appendix L.10 
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L.7 Sample Events Worksheet Entries for a RESMAN Event 
# Start Time Type Attribute Value 

1 0:00:20 RESMAN <fail> P1 
     
2 0:02:17 RESMAN <fix> P6 
     
In the first example “pump one” is failed, and in the second “pump six” is fixed. While the pump is 
failed, it is not available to the subject. When it is fixed, it is available, but in the off state.  Each of the 
eight pumps is controlled in the same manner. 

The format for several entries is in  MATB_EVENTS-template-resman.xml, Appendix L.12 
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L.8  Sample Events Worksheet Entries for a SCHED Event 
# Start Time Type Attribute Value 

1 0:01:00 SCHED <task> COMM 
   <action> START 
   <update> NULL 
   <response> NULL 
     
2 0:06:30 SCHED <task> COMM 
   <action> STOP 
   <update> NULL 
   <response> NULL 
     
3 0:02:15 SCHED <task> TRACK 
   <action> AUTO 
   <update> NULL 
   <response> NULL 
     
4 0:05:45 SCHED <task> TRACK 
   <action> MANUAL 
   <update> MEDIUM 
   <response> LOW 
     
5 0:00:05 SCHED <task> RESMAN 
   <action> START 
   <update> NULL 
   <response> NULL 
     
6 0:00:10 SCHED <task> RESSYS 
   <action> START 
   <update> NULL 
   <response> NULL 
     
7 0:00:15 SCHED <task> SYSMON 
   <action> START 
   <update> NULL 
   <response> NULL 
The SCHED task visually shows the current state and a “look-ahead” for the COMM and TRACK task.  
While specific COMM audio files are activated by COMM entries, each TRACK session is started and 
stopped with SCHED.  Normally, the RESMAN or SYSMON tasks (or RESSYS for both) are started and 
are active for the duration of the run.  
The format for these entries is in  MATB_EVENTS-template-sched.xml
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L.9  Sample Events Worksheet Entries for a SYSMON Event 
# Start Time Type Attribute Value 

1 0:01:00 SYSMON <monitoringLightType> GREEN 
     
2 0:01:30 SYSMON <monitoringLightType> RED 
     
3 0:02:00 SYSMON <monitoringScaleNumber> ONE 
   <monitoringScaleDirection> UP 
     
4 0:02:00 SYSMON <monitoringScaleNumber> ONE 
   <monitoringScaleDirection> DOWN 
     
5 0:02:00 SYSMON <monitoringScaleNumber> TWO 
   <monitoringScaleDirection> UP 
     
6 0:02:00 SYSMON <monitoringScaleNumber> TWO 
   <monitoringScaleDirection> DOWN 
     
7 0:02:00 SYSMON <monitoringScaleNumber> THREE 
   <monitoringScaleDirection> UP 
     
8 0:02:00 SYSMON <monitoringScaleNumber> THREE 
   <monitoringScaleDirection> DOWN 
     
9 0:02:00 SYSMON <monitoringScaleNumber> FOUR 
   <monitoringScaleDirection> UP 
     
10 0:02:00 SYSMON <monitoringScaleNumber> FOUR 
   <monitoringScaleDirection> DOWN 
     
The SYSMON task changes the state of lights and scales. 

The format for these entries is in  MATB_EVENTS-template-sysmon.xml
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L.10  MATB_EVENTS-template-start.xml 
?xml version="1.0" encoding="UTF-8" ?>  
<!-- Multi-Attribute Task Battery Events -->  
<!-- Start Template File --> 
<!-- Created on 03-02-2009 --> 
<!-- Contains the template to save as the initial file --> 
<!-- and then copy / paste /edit entries from other template files --> 
<!-- Since most runs will have at least one WRS event, it's template is included --> 
<MATB-EVENTS> 
<!-- Start MATB Timer -->  
<event startTime="0:00:00"> 
 <control>START</control>
</event> 
<!-- Workload Rating -->  
<event startTime="0:01:00"> 

<wrs>START</wrs>
</event> 
<!-- Stop MATB Timer and end experiment -->  
<event startTime="0:02:00"> 

<control>END</control>
</event> 
</MATB-EVENTS>
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L.11   MATB_EVENTS-template-comm.xml 
<?xml version="1.0" encoding="UTF-8" ?>  
<!-- Multi-Attribute Task Battery Events -->  
<!-- COMM Task Template File --> 
<!-- Created on 03-02-2009 --> 
<!-- Contains the templates to copy / paste /edit for the COMM task  --> 
<!-- Includes the START / STOP control tags and COMM entries for the SCHED task --> 
<!-- The startTime= attribute and freq tag values will have to be edited --> 
<!-- 112.500 and 126.500 are the mid-frequencies for the NAV and COM radios --> 
<MATB-EVENTS> 
<!-- Start MATB Timer -->  
<event startTime="0:00:00"> 

<control>START</control>
</event> 
<!-- Sched task: COMM START -->  
<event startTime="0:00:05"> 
   <sched> 
      <task>COMM</task>
      <action>START</action>
      <update>NULL</update>
      <response>NULL</response>
  </sched>  

</event> 
<!-- To play the OTHER_COM1_126-500.wav --> 
<event startTime="0:00:30"> 
   <comm> 
      <ship>OTHER</ship>
      <radio>COM1</radio>
      <freq>126.500</freq>
   </comm>  
</event> 
<!-- To play the OTHER_COM2_126-500.wav --> 
<event startTime="0:01:00"> 
  <comm> 
      <ship>OTHER</ship> 
      <radio>COM2</radio>
      <freq>126.500</freq> 
   </comm>  
</event> 
<!-- To play the OTHER_NAV1_112-500.wav --> 
<event startTime="0:01:30"> 
  <comm> 
      <ship>OTHER</ship> 
      <radio>NAV1</radio> 
      <freq>112.500</freq> 
   </comm>  
</event> 
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<!-- To play the OTHER_NAV2_112-500.wav --> 
<event startTime="0:02:00"> 
  <comm> 
      <ship>OTHER</ship> 
      <radio>NAV2</radio> 
      <freq>112.500</freq> 
   </comm>  
</event> 
<!-- To play the OWN_COM1_126-500.wav --> 
<event startTime="0:02:30"> 
  <comm> 
      <ship>OWN</ship> 
      <radio>COM1</radio> 
      <freq>126.500</freq> 
   </comm>  
</event> 
<!-- To play the OWN_COM2_126-500.wav --> 
<event startTime="0:03:00"> 
  <comm> 
      <ship>OWN</ship> 
      <radio>COM2</radio> 
      <freq>126.500</freq> 
   </comm>  
</event> 
<!-- To play the OWN_NAV1_112-500.wav --> 
<event startTime="0:03:30"> 
  <comm> 
      <ship>OWN</ship> 
      <radio>NAV1</radio> 
      <freq>112.500</freq> 
   </comm>  
</event> 
<!-- To play the OWN_NAV2_112-500.wav --> 
<event startTime="0:04:00"> 
  <comm> 
      <ship>OWN</ship> 
      <radio>NAV2</radio> 
      <freq>112.500</freq> 
   </comm>  
</event> 
<!-- Sched task: COMM STOP -->  
<event startTime="0:04:30">   
    <sched>   
      <task>COMM</task>
      <action>STOP</action>
      <update>NULL</update>
      <response>NULL</response>
  </sched>  

</event> 

<!-- Stop MATB Timer and end experiment -->  
<event startTime="0:05:00"> 
 <control>END</control>
</event> 
</MATB-EVENTS>
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L.12 MATB_EVENTS-template-resman.xml

<?xml version="1.0" encoding="UTF-8" ?>  
<!-- Multi-Attribute Task Battery Events --> 
<!-- RESMAN Task Template File --> 
<!-- Created on 03-03-2009 --> 
<!-- Contains the templates for copy / paste /edit for the RESMAN task  --> 
<!-- Includes the START / STOP control tags and RESMAN entries for the SCHED task --> 
<!-- The startTime= attribute and pump number tag values will have to be edited --> 
<!-- If both RESMAN and SYSMON task are active a single SCHED event will activate both --> 
<MATB-EVENTS> 
<!-- Start MATB Timer -->  
<event startTime="0:00:00"> 
  <control>START</control>
</event> 
<!-- Start both Resource Management and System Monitoring tasks  -->  
<event startTime="0:00:01"> 
  <sched> 
      <task>RESSYS</task> 
      <action>START</action> 
      <update>NULL</update> 
      <response>NULL</response> 
   </sched>  
</event> 
<!-- Start Resource Management task  -->  
<event startTime="0:00:02"> 
  <sched> 
      <task>RESMAN</task> 
      <action>START</action> 
      <update>NULL</update> 
      <response>NULL</response> 
   </sched>  
</event> 
<!-- Fail pump 1  -->   
<event startTime="0:01:00"> 
  <resman> 
      <fail>P1</fail> 
   </resman>  
</event> 
<!-- Fix pump 1  -->   
<event startTime="0:01:30"> 
  <resman> 
      <fix>P1</fix>
  </resman>  
</event> 
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<!-- Fail pump 2  -->   
<event startTime="0:02:00"> 
 <resman> 
      <fail>P2</fail> 
  </resman>  
</event> 
<!-- Fix pump 2  -->   
<event startTime="0:02:30"> 
  <resman> 
      <fix>P2</fix>
  </resman>  
</event> 
<!-- Fail pump 3  -->   
<event startTime="0:03:00"> 
  <resman> 
      <fail>P3</fail> 
   </resman>  
</event> 
<!-- Fix pump 3  -->   
<event startTime="0:03:30"> 
  <resman> 
      <fix>P3</fix>
  </resman>  
</event> 
<!-- Fail pump 4  -->   
<event startTime="0:04:00"> 
  <resman> 
      <fail>P4</fail> 
  </resman>  
</event> 
<!-- Fix pump 4  -->   
<event startTime="0:04:30"> 
  <resman> 
      <fix>P4</fix>
  </resman>  
</event> 
<!-- Fail pump 5  -->   
<event startTime="0:05:00"> 
  <resman> 
      <fail>P5</fail> 
   </resman>  
</event> 
<!-- Fix pump 5  -->   
<event startTime="0:05:30"> 
  <resman> 
      <fix>P5</fix>
  </resman>  
</event> 
<!-- Fail pump 6  -->   
<event startTime="0:06:00"> 
  <resman> 
      <fail>P6</fail> 
  </resman>  
</event> 
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<!-- Fix pump 6  -->   
<event startTime="0:06:30"> 
  <resman> 
      <fix>P6</fix>
  </resman>  
</event> 
<!-- Fail pump 7  -->   
<event startTime="0:07:00"> 
  <resman> 
      <fail>P7</fail> 
   </resman>  
</event> 
<!-- Fix pump 7  -->   
<event startTime="0:07:30"> 
  <resman> 
      <fix>P7</fix>
  </resman>  
</event> 
<!-- Fail pump 8  -->   
<event startTime="0:08:00"> 
  <resman> 
      <fail>P8</fail> 
  </resman>  
</event> 
<!-- Fix pump 8  -->   
<event startTime="0:08:30"> 
  <resman> 
      <fix>P8</fix>
  </resman>  
</event> 
<!-- Stop MATB Timer and end experiment -->  
<event startTime="0:09:00"> 
  <control>END</control>
</event> 
</MATB-EVENTS>
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L.13  MATB_EVENTS-template-sched.xml 
<?xml version="1.0" encoding="UTF-8" ?>  
<!-- Multi-Attribute Task Battery Events -->  
<!-- SCHED Template File --> 
<!-- Created on 03-03-2009 --> 
<!-- Contains the templates to  copy / paste /edit SCHED entries --> 
<!-- TRACK target update rate values: LOW, MEDIUM, HIGH --> 
<!-- TRACK joystick response values: LOW, MEDIUM, HIGH --> 
<MATB-EVENTS> 
<event startTime="0:00:00"> 
<!-- Start MATB Timer -->  
  <control>START</control>
</event> 
<event startTime="0:01:00"> 
<!-- Start Communications task  -->  
  <sched> 
      <task>COMM</task> 
      <action>START</action> 
      <update>NULL</update> 
      <response>NULL</response> 
   </sched>  
</event> 
<event startTime="0:03:00">  
 <!-- Stop Communications task   -->  
    <sched >   
      <task>COMM</task>   
      <action>STOP</action> 
      <update>NULL</update> 
      <response>NULL</response> 
   </sched>  
</event> 
<event startTime="0:03:11"> 
<!-- Start Resource Management task  -->  
  <sched> 
      <task>RESMAN</task> 
      <action>START</action> 
      <update>NULL</update> 
      <response>NULL</response> 
   </sched>  
</event> 

<event startTime="0:03:21"> 
<!-- Start Resource Management and System Monitoring tasks  -->  
  <sched> 
      <task>RESSYS</task> 
      <action>START</action> 
      <update>NULL</update> 
      <response>NULL</response> 
   </sched>  
</event> 
<event startTime="0:03:31"> 
<!-- Start System Monitoring task  -->  
  <sched> 
      <task>SYSMON</task> 
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      <action>START</action> 
      <update>NULL</update> 
      <response>NULL</response> 
   </sched>  
</event> 
<event startTime="0:04:05"> 
<!-- Start Tracking task: Edit update and response as required --> 
  <sched> 
      <task>TRACK</task> 
      <action>MANUAL</action> 
      <update>MEDIUM</update>
      <response>MEDIUM</response> 
   </sched>  
</event> 
<event startTime="0:04:35"> 
<!-- Stop Tracking task -->  
  <sched > 
      <task>TRACK</task> 
      <action>AUTO</action> 
      <update>NULL</update> 
      <response>NULL</response> 
   </sched>  
</event> 
<event startTime="0:05:00"> 
<!-- Stop MATB Timer and end experiment -->  
  <control>END</control>
</event> 
</MATB-EVENTS> 
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L.14  MATB_EVENTS-template-sysmon.xml 
<?xml version="1.0" encoding="UTF-8" ?>  
<!-- Multi-Attribute Task Battery Events -->  
<!-- SYSMON Template File --> 
<!-- Created on 03-03-2009 --> 
<!-- Contains the templates to  copy / paste /edit SYSMON entries --> 
<!-- If both RESMAN and SYSMON task are active a single SCHED event will activate both --> 
<MATB-EVENTS> 
<event startTime="0:00:00"> 
<!-- Start MATB Timer -->  
  <control>START</control>
</event> 
<event startTime="0:00:01"> 
<!-- Start Resource Management and System Monitoring tasks  -->  
  <sched> 
      <task>RESSYS</task> 
      <action>START</action> 
      <update>NULL</update> 
      <response>NULL</response> 
   </sched>  
</event> 
<event startTime="0:00:02"> 
<!-- Start System Monitoring task  -->  
  <sched> 
      <task>SYSMON</task> 
      <action>START</action> 
      <update>NULL</update> 
      <response>NULL</response> 
   </sched>  
</event> 
<event startTime="0:00:13"> 
<!-- Turn The GREEN light, Normally ON to OFF -->  
  <sysmon> 
      <monitoringLightType>GREEN</monitoringLightType> 
   </sysmon>  
</event> 
<event startTime="0:00:23"> 
<!-- Turn The RED light, Normally OFF to ON -->  
  <sysmon> 
      <monitoringLightType>RED</monitoringLightType> 
   </sysmon>  
</event>
<event startTime="0:00:33"> 
<!-- Move SCALE ONE DOWN -->  
  <sysmon> 
      <monitoringScaleNumber>ONE</monitoringScaleNumber> 
      <monitoringScaleDirection>DOWN</monitoringScaleDirection> 
   </sysmon>  
</event> 
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<event startTime="0:00:43"> 
<!-- Move SCALE ONE UP -->  
  <sysmon> 
      <monitoringScaleNumber>ONE</monitoringScaleNumber> 
      <monitoringScaleDirection>UP</monitoringScaleDirection> 
   </sysmon>  
</event> 
<event startTime="0:00:53"> 
<!-- Move SCALE TWO DOWN -->  

<sysmon> 
      <monitoringScaleNumber>TWO</monitoringScaleNumber> 
      <monitoringScaleDirection>DOWN</monitoringScaleDirection> 
   </sysmon>  
</event> 
<event startTime="0:01:03"> 
<!-- Move SCALE TWO UP -->  

<sysmon> 
      <monitoringScaleNumber>TWO</monitoringScaleNumber> 
      <monitoringScaleDirection>UP</monitoringScaleDirection> 
   </sysmon>  
</event> 
<event startTime="0:01:13"> 
<!-- Move SCALE THREE DOWN -->  

<sysmon> 
      <monitoringScaleNumber>THREE</monitoringScaleNumber> 
      <monitoringScaleDirection>DOWN</monitoringScaleDirection> 
   </sysmon>  
</event> 
<event startTime="0:01:23"> 
<!-- Move SCALE THREE UP -->  
  <sysmon> 
      <monitoringScaleNumber>THREE</monitoringScaleNumber> 
      <monitoringScaleDirection>UP</monitoringScaleDirection> 
   </sysmon>  
</event> 
<event startTime="0:01:33"> 
<!-- Move SCALE FOUR DOWN -->  
  <sysmon> 
      <monitoringScaleNumber>FOUR</monitoringScaleNumber> 
      <monitoringScaleDirection>DOWN</monitoringScaleDirection> 
   </sysmon>  
</event> 
<event startTime="0:01:43"> 
<!-- Move SCALE FOUR UP -->  
  <sysmon> 
      <monitoringScaleNumber>FOUR</monitoringScaleNumber> 
      <monitoringScaleDirection>UP</monitoringScaleDirection> 
   </sysmon>  
</event> 
<event startTime="0:02:00"> 
<!-- Stop MATB Timer and end experiment --> 

<control>END</control>
</event> 
</MATB-EVENTS>
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L.15  MATB_EVENTS-template-track.xml 
<?xml version="1.0" encoding="UTF-8" ?>  
<!-- Multi-Attribute Task Battery Events -->  
<!-- Start Template File --> 
<!-- Created on 03-03-2009 --> 
<!-- Contains the templates for  copy / paste /edit TRACK entries --> 
<!-- TRACK target update rate values: LOW, MEDIUM, HIGH --> 
<!-- TRACK joystick response values: LOW, MEDIUM, HIGH --> 
<!-- The TRACK task is controlled through SCHED entries --> 
<MATB-EVENTS> 
<event startTime="0:00:00"> 
<!-- Start MATB Timer -->  
  <control>START</control>
</event> 
<event startTime="0:00:05"> 
<!-- Start Tracking task: Edit update and response as required --> 

<sched> 
      <task>TRACK</task> 
      <action>MANUAL</action> 
      <update>MEDIUM</update>
      <response>MEDIUM</response> 
   </sched>  
</event> 
<event startTime="0:01:55"> 
<!-- Stop Tracking task -->  
  <sched > 
      <task>TRACK</task> 
      <action>AUTO</action> 
      <update>NULL</update> 
      <response>NULL</response> 
   </sched>  
</event> 
<event startTime="0:02:00"> 
<!-- Stop MATB Timer and end experiment -->  
  <control>END</control>
</event> 
</MATB-EVENTS>
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M   COMM Audio Filenames  

# Audio Filename 
1 OWN_COM1_124-575.wav 
2 OWN_COM1_125-550.wav 
3 OWN_COM1_126-525.wav 
4 OWN_COM1_127-500.wav 
5 OWN_COM1_128-475.wav 
6 OWN_COM1_129-450.wav 
7 OWN_COM1_128-575.wav 
8 OWN_COM1_127-550.wav 
9 OWN_COM1_126-450.wav 
10 OWN_COM1_125-500.wav 
11 OWN_COM2_129-575.wav 
12 OWN_COM2_128-550.wav 
13 OWN_COM2_127-525.wav 
14 OWN_COM2_126-475.wav 
15 OWN_COM2_125-500.wav 
16 OWN_COM2_124-450.wav 
17 OWN_COM2_125-575.wav 
18 OWN_COM2_126-550.wav 
19 OWN_COM2_127-500.wav 
20 OWN_COM2_128-525.wav 
21 OWN_NAV1_110-650.wav 
22 OWN_NAV1_111-600.wav 
23 OWN_NAV1_112-550.wav 
24 OWN_NAV1_113-500.wav 
25 OWN_NAV1_114-450.wav 
26 OWN_NAV1_115-400.wav 
27 OWN_NAV1_114-650.wav 
28 OWN_NAV1_113-600.wav 
29 OWN_NAV1_112-450.wav 
30 OWN_NAV1_111-500.wav 
31 OWN_NAV2_115-650.wav 
32 OWN_ NAV2_114-600.wav 
33 OWN_ NAV2_113-550.wav 
34 OWN_ NAV2_112-450.wav 
35 OWN_ NAV2_111-400.wav 
36 OWN_ NAV2_110-500.wav 
37 OWN_ NAV2_111-650.wav 
38 OWN_ NAV2_112-600.wav 
39 OWN_ NAV2_113-500.wav 
40 OWN_ NAV2_114-450.wav 



Appendix Page 136 

# Audio Filename 
41 OTHER_COM1_118-325.wav 
42 OTHER_COM1_120-825.wav 
43 OTHER_COM1_124-350.wav 
44 OTHER_COM1_126-175.wav 
45 OTHER_COM1_127-725.wav 
46 OTHER_COM1_128-525.wav 
47 OTHER_COM1_130-875.wav 
48 OTHER_COM1_132-950.wav 
49 OTHER_COM1_134-175.wav 
50 OTHER_COM1_135-225.wav 
51 OTHER_COM2_118-275.wav 
52 OTHER_COM2_120-775.wav 
53 OTHER_COM2_124-500.wav 
54 OTHER_COM2_126-025.wav 
55 OTHER_COM2_127-675.wav 
56 OTHER_COM2_128-475.wav 
57 OTHER_COM2_130-725.wav 
58 OTHER_COM2_132-800.wav 
59 OTHER_COM2_134-025.wav 
60 OTHER_COM2_135-175.wav 
61 OTHER_NAV1_108-350.wav 
62 OTHER_NAV1_109-250.wav 
63 OTHER_NAV1_110-400.wav 
64 OTHER_NAV1_111-950.wav 
65 OTHER_NAV1_112-150.wav 
66 OTHER_NAV1_113-000.wav 
67 OTHER_NAV1_114-500.wav 
68 OTHER_NAV1_115-750.wav 
69 OTHER_NAV1_116-450.wav 
70 OTHER_NAV1_117-650.wav 
71 OTHER_NAV2_108-750.wav 
72 OTHER_NAV2_109-650.wav 
73 OTHER_NAV2_110-800.wav 
74 OTHER_NAV2_111-350.wav 
75 OTHER_NAV2_112-550.wav 
76 OTHER_NAV2_113-400.wav 
77 OTHER_NAV2_114-900.wav 
78 OTHER_NAV2_115-050.wav 
79 OTHER_NAV2_116-850.wav 
80 OTHER_NAV2_117-950.wav 
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N Crimson Editor Screen Capture of a MATB_EVENTS File 
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N.1  XML Notepad 2007 Screen Capture of a MATB_EVENTS File  
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O   A complete MATB_II_*.txt output file for a 5 minute run 

#��02�11�2011�����20:42:14�����MATB_2011_02112041.txt�
#�
#�Events�Filename:�MATB_EVENTS�5min�Rating.xml�

TIME� EVENT� ACTION� REMARKS�
00:00:00.0 
00:00:17.0 
00:00:17.5 
00:00:18.0 
00:00:18.5 
00:00:19.0 
00:00:19.3 
00:00:20.1 
00:00:21.2 
00:00:22.2 
00:00:22.6 
00:00:23.5 
00:00:30.0 
00:00:33.1 
00:00:34.0 
00:00:35.0 
00:00:40.0 
00:00:40.0 
00:00:45.0 
00:00:45.6 
00:00:48.1 
00:00:48.4 
00:00:49.2 
00:00:49.5 
00:00:50.8 
00:00:52.7 
00:00:53.0 
00:00:53.4 
00:00:55.5 
00:00:56.9 
00:01:00.0 
00:01:03.1 
00:01:13.0 
00:01:15.0 
00:01:19.4 
00:01:19.9 
00:01:20.0 
00:01:20.3 
00:01:24.8 
00:01:28.8 
00:01:29.7 
00:01:30.0 
00:01:31.3 
00:01:39.0 
00:01:41.5 
00:01:48.5 

     
   1 
   2 
   3 
   4 
   5 
     
     
     
     
     
     
     
     
   6 
   7 
   8 
     
   9 
     
     
     
     
     
     
     
  10 
     
     
     
     
     
  11 
  12 
     
     
  13 
     
     
     
     
     
     
     
     
     

Device Initialization:                        
Event Processed:  Control 
Event Processed:  Scheduling                  
Event Processed:  Scheduling                  
Event Processed:  Resource Management         
Event Processed:  System Monitoring           
Subject Response: Resource Management         
Subject Response: System Monitoring           
Subject Response: Resource Management         
Subject Response: Resource Management         
Subject Response: Resource Management         
Subject Response: Resource Management         
Recording Interval Triggered: Resource Management 
Recording Interval Triggered: Tracking  
Event Processed:  Scheduling                  
Event Processed:  Resource Management         
Event Processed:  Communications              
Event Terminated: Communications 
Event Processed:  Resource Management         
Subject Response: Resource Management         
Recording Interval Triggered: Tracking  
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Event Processed:  System Monitoring           
Subject Response: Communications              
Subject Response: Communications              
Subject Response: System Monitoring           
Recording Interval Triggered: Resource Management 
Recording Interval Triggered: Tracking  
Event Processed:  System Monitoring           
Event Processed:  Resource Management         
Subject Response: System Monitoring           
Subject Response: System Monitoring           
Event Processed:  Communications              
Subject Response: System Monitoring           
Subject Response: Resource Management         
Subject Response: Resource Management         
Subject Response: Resource Management         
Recording Interval Triggered: Resource Management 
Subject Response: Resource Management         
Subject Response: Resource Management         
Subject Response: Resource Management         
Subject Response: Resource Management         

- Joystick Connected -    

- RESMAN and SYSMON Active 
- TRACK in Manual Mode 
- Pump ONE Failed 
- GREEN Light 
- Pump TWO 
- GREEN Light 
- Pump FOUR 
- Pump THREE 
- Pump SIX 
- Pump FIVE 

- COMM Session Started 
- Pump ONE Fixed 
- COM ONE OWN Ship 

- Pump FIVE Failed 
- Pump ONE 

- COM1 Response Inappropriate 
- FREQ Integer 
- FREQ Integer 
- FREQ Decimal 
- FREQ Decimal 
- RED Light 
- FREQ Decimal 
- Enter Button Selected 
- RED Light 

- Scale TWO 
- Pump FIVE Fixed 
- Scale TWO 
- Scale TWO Resp. Inappropriate 
- COM TWO OTHER Ship 
- Scale TWO Resp.  Inappropriate 
- Pump FIVE 
- Pump FOUR 
- Pump THREE 
- Pump FOUR 
- Pump ONE 
- Pump EIGHT 
- Pump THREE 



Appendix Page 140 

00:01:50.0 
00:02:00.0 
00:02:00.0 
00:02:05.0 
00:02:13.0 
00:02:15.8 
00:02:20.0 
00:02:21.7 
00:02:22.7 
00:02:22.9 
00:02:23.3 
00:02:24.8 
00:02:25.1 
00:02:25.2 
00:02:25.3 
00:02:25.3 
00:02:25.4 
00:02:25.4 
00:02:25.5 
00:02:25.6 
00:02:25.6 
00:02:26.6 
00:02:28.3 
00:02:30.0 
00:02:30.0 
00:02:33.0 
00:02:41.8 
00:02:42.9 
00:02:44.7 
00:02:45.0 
00:02:50.0 
00:02:53.0 
00:02:54.6 
00:03:00.0 
00:03:00.1 
00:03:03.9 
00:03:05.0 
00:03:05.7 
00:03:06.4 
00:03:08.4 
00:03:08.9 
00:03:10.0 
00:03:15.0 
00:03:15.1 
00:03:15.8 
00:03:17.0 
00:03:17.3 
00:03:18.0 
00:03:18.6 
00:03:18.9 
00:03:19.1 
00:03:19.4 
00:03:21.1 
00:03:23.7 
00:03:24.6 
00:03:25.0 

     
  14 
     
  15 
  16 
     
  17 
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
  19 
     
  20 
     
     
     
  21 
  22 
  23 
     
     
     
     
  24 
     
     
     
     
  25 
  26 
     
     
     
     
  27 
     
     
     
     
     
     
     
  28 

Event Terminated: Communications 
Event Processed:  Scheduling                  
Recording Interval Triggered: Resource Management 
Event Processed:  Communications              
Event Processed:  System Monitoring           
Subject Response: System Monitoring           
Event Processed:  Resource Management         
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Event Processed:  Scheduling                  
Recording Interval Triggered: Resource Management 
Event Processed:  System Monitoring           
Subject Response: Resource Management         
Event Terminated: System Monitoring 
Subject Response: Resource Management         
Event Processed:  Scheduling                  
Event Processed:  Resource Management         
Event Processed:  System Monitoring           
Subject Response: System Monitoring           
Recording Interval Triggered: Resource Management 
Recording Interval Triggered: Tracking  
Subject Response: Resource Management         
Event Processed:  Scheduling                  
Subject Response: Resource Management         
Subject Response: Resource Management         
Subject Response: Resource Management         
Subject Response: Resource Management         
Event Processed:  Communications              
Event Processed:  Resource Management         
Recording Interval Triggered: Tracking  
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Event Processed:  Resource Management         
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Communications              
Subject Response: Resource Management         
Event Processed:  Workload Rating Scale 

- TRACK in Auto Mode 

- NAV TWO OTHER Ship 
- GREEN Light 
- GREEN Light 
- Pump EIGHT Failed 
- NAV2 Response Inappropriate 
- FREQ Integer 
- FREQ Integer 
- FREQ Integer 
- FREQ Decimal 
- FREQ Decimal 
- FREQ Decimal 
- FREQ Decimal 
- FREQ Decimal 
- FREQ Decimal 
- FREQ Decimal 
- FREQ Decimal 
- FREQ Decimal 
- FREQ Decimal 
- FREQ Decimal 
- Enter Button Selected 
- COMM Session Ended 

- Scale THREE 
- Pump THREE 
- Scale ONE 
- Pump TWO 
- TRACK in Manual Mode 
- Pump EIGHT Fixed 
- RED Light 
- RED Light 

- Pump THREE 
- COMM Session Started 
- Pump ONE 
- Pump TWO 
- Pump EIGHT 
- Pump THREE 
- COM ONE OWN Ship 
- Pump TWO Failed 

- COM ONE 
- FREQ Integer 
- FREQ Integer 
- Pump FOUR Failed 
- FREQ Decimal 
- FREQ Decimal 
- FREQ Decimal 
- FREQ Decimal 
- FREQ Decimal 
- Enter Button Selected 
- Pump THREE 
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00:03:25.2 
00:03:30.0 
00:03:30.0 
00:03:36.6 
00:03:45.0 
00:03:50.0 
00:03:55.0 
00:04:00.1 
00:04:00.2 
00:04:00.5 
00:04:02.1 
00:04:05.0 
00:04:13.0 
00:04:15.0 
00:04:15.6 
00:04:27.3 
00:04:30.0 
00:04:31.0 
00:04:31.8 
00:04:32.6 
00:04:33.0 
00:04:33.1 
00:04:35.3 
00:04:39.8 
00:04:40.0 
00:04:44.2 
00:04:45.0 
00:04:55.0 
00:05:00.0 

     
  29 
     
     
  30 
  31 
  32 
     
     
  33 
     
  34 
  35 
     
     
   - 
     
     
     
     
  36 
     
     
     
  37 
     
  38 
  39 
  40 

Recording Interval Triggered: Tracking  
Event Processed:  System Monitoring           
Recording Interval Triggered: Resource Management 
Subject Response: System Monitoring           
Event Processed:  Communications              
Event Processed:  Resource Management         
Event Processed:  Resource Management         
Recording Interval Triggered: Resource Management 
Subject Response: Resource Management         
Event Processed:  Scheduling                  
Subject Response: Resource Management         
Event Processed:  Resource Management         
Event Processed:  System Monitoring           
Event Terminated: Communications 
Subject Response: System Monitoring           
Information: MATB Lost The Focus For          
Recording Interval Triggered: Resource Management 
Subject Response: Resource Management         
Subject Response: Resource Management         
Subject Response: Resource Management         
Event Processed:  System Monitoring           
Subject Response: Resource Management         
Subject Response: System Monitoring           
Subject Response: Resource Management         
Event Processed:  Scheduling                  
Subject Response: Resource Management         
Event Processed:  Workload Rating Scale 
Event Processed:  Resource Management         
Event Processed:  Control 

- Scale ONE 

- Scale ONE 
- COM TWO OTHER Ship 
- Pump TWO Fixed 
- Pump FOUR Fixed 

- Pump TWO 
- TRACK in Auto Mode 
- Pump FOUR 
- Pump THREE Failed 
- GREEN Light 

- GREEN Light 
- 00:02.2 [min:sec.tenths]  

- Pump ONE 
- Pump TWO 
- Pump EIGHT 
- RED Light 
- Pump SEVEN 
- RED Light 
- Pump ONE 
- COMM Session Ended 
- Pump TWO 

- Pump THREE Fixed 
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P  A complete MATB_EVENTS file 

<?xml version="1.0" encoding="UTF-8" ?>
- <!-- Multi-Attribute Task Battery Events -->
- <!-- Modified on 01-21-2011 -->
- <!-- Sample 5 minute run with all four tasks and multi WRS questionnaire 
occurences -->

- <MATB-EVENTS>
- <!-- CNTRL: Start MATB Timer -->

- <event startTime="0:00:00">
<control>START</control>

</event>
- <!-- SCHED: Start RESMAN & SYSMON Tasks -->

- <event startTime="0:00:01">
- <sched>

<task>RESSYS</task>
<action>START</action>
<update>NULL</update>
<response>NULL</response>

</sched>
</event>

- <!-- SCHED: TRACK to Manual Mode -->
- <event startTime="0:00:02">
- <sched>

<task>TRACK</task>
<action>MANUAL</action>
<update>HIGH</update>
<response>MEDIUM</response>

</sched>
</event>

- <!-- RESMAN: Fail pump 1 -->
- <event startTime="0:00:05">
- <resman>

<fail>P1</fail>
</resman>
</event>

- <!-- SYSMON: Green Light OFF -->
- <event startTime="0:00:08">
- <sysmon activity="START">

<monitoringLightType>GREEN</monitoringLightType>
</sysmon>
</event>

- <!-- SCHED: COMM Start Session -->
- <event startTime="0:00:10">
- <sched>

<task>COMM</task>
<action>START</action>
<update>NULL</update>
<response>NULL</response>
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</sched>
</event>

- <!-- COMM: OTHER Ship Freq Change -->
- <event startTime="0:00:15">
- <comm>

<ship>OTHER</ship>
<radio>COM2</radio>
<freq>130.725</freq>

</comm>
</event>

- <!-- SYSMON: Red Light ON -->
- <event startTime="0:00:20">
- <sysmon>

<monitoringLightType>RED</monitoringLightType>
</sysmon>
</event>

- <!-- RESMAN: Fix pump 1 -->
- <event startTime="0:00:35">
- <resman>

<fix>P1</fix>
</resman>
</event>

- <!-- SYSMON: SCALE ONE UP -->
- <event startTime="0:00:38">
- <sysmon>

<monitoringScaleNumber>ONE</monitoringScaleNumber>
<monitoringScaleDirection>UP</monitoringScaleDirection>

</sysmon>
</event>

- <!-- COMM: OWN Ship Freq Change   -->
- <event startTime="0:00:40">
- <comm>

<ship>OWN</ship>
<radio>COM1</radio>
<freq>127.550</freq>

</comm>
</event>

- <!-- RESMAN: Fail pump 5 -->
- <event startTime="0:00:45">
- <resman>

<fail>P5</fail>
</resman>
</event>

- <!-- SYSMON: Red Light ON -->
- <event startTime="0:00:53">
- <sysmon>

<monitoringLightType>RED</monitoringLightType>
</sysmon>
</event>
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- <!-- SYSMON: SCALE TWO DOWN -->
- <event startTime="0:01:00">
- <sysmon>

<monitoringScaleNumber>TWO</monitoringScaleNumber>
<monitoringScaleDirection>DOWN</monitoringScaleDirection>

</sysmon>
</event>

- <!-- SYSMON: SCALE FOUR DOWN -->
- <event startTime="0:01:10">
- <sysmon>

<monitoringScaleNumber>FOUR</monitoringScaleNumber>
<monitoringScaleDirection>DOWN</monitoringScaleDirection>

</sysmon>
</event>

- <!-- RESMAN: Fix pump 5 -->
- <event startTime="0:01:15">
- <resman>

<fix>P5</fix>
</resman>
</event>

- <!-- COMM: OWN Ship Freq Change -->
- <event startTime="0:01:20">
- <comm>

<ship>OWN</ship>
<radio>COM2</radio>
<freq>126.475</freq>

</comm>
</event>

- <!-- SYSMON: SCALE TWO UP -->
- <event startTime="0:01:31">
- <sysmon>

<monitoringScaleNumber>TWO</monitoringScaleNumber>
<monitoringScaleDirection>UP</monitoringScaleDirection>

</sysmon>
</event>

- <!-- COMM: OWN Ship Freq Change -->
- <event startTime="0:01:45">
- <comm>

<ship>OWN</ship>
<radio>NAV1</radio>
<freq>111.600</freq>

</comm>
</event>

- <!-- SCHED: TRACK to Automatic Response Mode -->
- <event startTime="0:02:00">
- <sched>

<task>TRACK</task>
<action>AUTO</action>
<update>NULL</update>
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<response>NULL</response>
</sched>
</event>

- <!-- SYSMON: Green Light OFF -->
- <event startTime="0:02:10">
- <sysmon activity="START">

<monitoringLightType>GREEN</monitoringLightType>
</sysmon>
</event>

- <!-- COMM: OTHER Ship Freq Change -->
- <event startTime="0:02:20">
- <comm>

<ship>OTHER</ship>
<radio>NAV2</radio>
<freq>115.050</freq>

</comm>
</event>

- <!-- RESMAN: Fail pump 8 -->
- <event startTime="0:02:20">
- <resman>

<fail>P8</fail>
</resman>
</event>

- <!-- SCHED: COMM Stop Session -->
- <event startTime="0:02:30">
- <sched>

<task>COMM</task>
<action>STOP</action>
<update>NULL</update>
<response>NULL</response>

</sched>
</event>

- <!-- SYSMON: SCALE THREE UP -->
- <event startTime="0:02:33">
- <sysmon>

<monitoringScaleNumber>THREE</monitoringScaleNumber>
<monitoringScaleDirection>UP</monitoringScaleDirection>

</sysmon>
</event>

- <!-- WRS questionnaire -->
- <event startTime="0:02:40">

<wrs>START</wrs>
</event>

- <!-- SCHED: TRACK to Manual Mode -->
- <event startTime="0:02:45">
- <sched>

<task>TRACK</task>
<action>MANUAL</action>
<update>MEDIUM</update>
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<response>HIGH</response>
</sched>
</event>

- <!-- RESMAN: Fix pump 8 -->
- <event startTime="0:02:50">
- <resman>

<fix>P8</fix>
</resman>
</event>

- <!-- SYSMON: Red Light ON -->
- <event startTime="0:02:53">
- <sysmon>

<monitoringLightType>RED</monitoringLightType>
</sysmon>
</event>

- <event startTime="0:03:05">
- <sched>

<task>COMM</task>
<action>START</action>
<update>NULL</update>
<response>NULL</response>

</sched>
</event>

- <!-- Start Communications task and make radio change   -->
- <event startTime="0:03:10">
- <comm activity="START">

<ship>OWN</ship>
<radio>COM1</radio>
<freq>126.450</freq>

</comm>
</event>

- <!-- RESMAN: Fail pump 2 -->
- <event startTime="0:03:20">

- <resman>
<fail>P2</fail>

</resman>
</event>

- <!-- RESMAN: Fail pump 4 -->
- <event startTime="0:03:20">
- <resman>

<fail>P4</fail>
</resman>
</event>

- <!-- SYSMON: SCALE ONE DOWN -->
- <event startTime="0:03:23">
- <sysmon>

<monitoringScaleNumber>ONE</monitoringScaleNumber>
<monitoringScaleDirection>DOWN</monitoringScaleDirection>

</sysmon>
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</event>
- <!-- COMM: OTHER Ship Freq Change -->

- <event startTime="0:03:45">
- <comm>

<ship>OTHER</ship>
<radio>COM2</radio>
<freq>120.775</freq>

</comm>
</event>

- <!-- RESMAN: Fix pump 2 -->
- <event startTime="0:03:50">
- <resman>

<fix>P2</fix>
</resman>
</event>

- <!-- RESMAN: Fix pump 4 -->
- <event startTime="0:03:55">
- <resman>

<fix>P4</fix>
</resman>
</event>

- <!-- SCHED: TRACK to Automatic Response Mode -->
- <event startTime="0:04:00">
- <sched>

<task>TRACK</task>
<action>AUTO</action>
<update>NULL</update>
<response>NULL</response>

</sched>
</event>

- <!-- RESMAN: Fail pump 3 -->
- <event startTime="0:04:05">
- <resman>

<fail>P3</fail>
</resman>
</event>

- <!-- SYSMON: Green Light OFF -->
- <event startTime="0:04:13">
- <sysmon>

<monitoringLightType>GREEN</monitoringLightType>
</sysmon>
</event>

- <!-- SYSMON: SCALE TWO DOWN -->
- <event startTime="0:04:23">
- <sysmon>

<monitoringScaleNumber>TWO</monitoringScaleNumber>
<monitoringScaleDirection>DOWN</monitoringScaleDirection>

</sysmon>
</event>
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- <!-- SYSMON: Red Light ON -->
- <event startTime="0:04:33">
- <sysmon>

<monitoringLightType>RED</monitoringLightType>
</sysmon>
</event>

- <event startTime="0:04:40">
- <sched>

<task>COMM</task>
<action>STOP</action>
<update>NULL</update>
<response>NULL</response>

</sched>
</event>

- <!-- SYSMON: SCALE ONE UP -->
- <event startTime="0:04:41">

- <sysmon>
<monitoringScaleNumber>ONE</monitoringScaleNumber>
<monitoringScaleDirection>UP</monitoringScaleDirection>

</sysmon>
</event>

- <!-- WRS questionnaire -->
- <event startTime="0:04:45">

<wrs>START</wrs>
</event>

- <!-- RESMAN: Fix pump 3 -->
- <event startTime="0:04:55">
- <resman>

<fix>P3</fix>
</resman>
</event>

- <!-- CNTRL: Stop MATB Timer & End Run -->
- <event startTime="0:05:00">

<control>END</control>
</event>
</MATB-EVENTS>



Appendix Page 149 

P.1 MATB_EVENTS-sample-5min.xml 
Events for the first 53 seconds of the sample file. 
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P.2   Appendix CONTROL.xml 
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P.3 Appendix RESMAN.xml 
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Q  Multi-Attribute Task Battery (MATB) Communications Task Audio 
Scripts and Filenames 

Radio communications are a critical component of the air traffic control (ATC) system. Flight crews 
must monitor ATC radio communications to avoid potential traffic conflicts and be precisely where 
the air traffic controller wants them to be (taxiway, runway, arrival / departure route, etc).  The flight 
crew will normally communicate with multiple controllers and on multiple radio frequencies during 
a single flight.

One of the tasks in MATB is the radio communications task, where short audio utterances are played 
and the subject responds to the instructions. The audio utterances simulate an air traffic controller
directing the flight deck crew to tune either one of two voice communication radios or one of two 
navigation radio aids (e.g. VHF Omnidirectional Radio Range or VOR) to a new frequency.  The 
subject tunes the radio if the message is for them and ignores it when it is intended for another 
aircraft.  

The time sequence of an experimental run is managed by the contents of an XML file called the 
MATB_EVENTS file. The correct audio file to play is selected by file name which is composed by 
concatenating three elements from the events file. These are type of aircraft (known as “ship”), the 
“radio” name and the “freq” (frequency).  A couple of examples from MATB_EVENTS file are: 
 
<comm> 
      <ship>OWN</ship> 
      <radio>COM1</radio> 
      <freq>118.025</freq> 
</comm> 
 
And

<comm> 
      <ship>OTHER</ship> 
      <radio>NAV2</radio> 
      <freq>112.550</freq> 
</comm> 
 
The audio filename for the first would be OWN_COM1_118-025.wav and for the second, 
OTHER_NAV2_112-550.wav.

The OWN SHIP utterance for the first named file would be: 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM ONE radio to frequency 
ONE ONE EIGHT POINT ZERO TWO FIVE” 

And for the OTHER SHIP file, the utterance would be: 
“FEDEX THREE ZERO THREE, FEDEX THREE ZERO THREE, tune your NAV TWO radio to 
frequency ONE ONE TWO POINT FIVE FIVE ZERO” 

Each digit of the frequency is pronounced phonetically rather than spoken as a number, for example 
“ONE ONE EIGHT POINT ZERO TWO FIVE” rather than “One Eighteen and twenty five 
thousandths”.
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An aeronautical radio call sign consists of two parts, the first part is a nickname to differentiate 
similar named airlines or organizations. They are not the same as an airline’s International Civil 
Aviation Organization (ICAO) or International Air Transport Association (IATA) designations. The 
second part is a numeric designation, usually the flight identification number for an airline or the last 
four characters of the registration marking for military or business aircraft. However, there are many 
exceptions, to either avoid confusion caused by similar flight identification numbers in proximity or 
some other reason. Military aircraft flying tactical missions do not normally follow this convention. 
Langley Research Center (LaRC) uses NASA 5xx for its aircraft.

The nickname part of the call sign is not spoken phonetically, but the numeric part normally is. The 
call sign used in MATB for OWN is always “NASA 504”, which is LaRC’s Cessna 206. This call 
sign would normally be spoken as “NASA FIVE ZERO FOUR”, rather than “NOVEMBER ALPHA 
SIERRA ALPHA FIVE ZERO FOUR”.

There are no NASA call signs in the list of OTHER aircraft. A list of real world OTHER calls signs 
used for the radio communications is listed in Appendix Q.1.9.

MATB expects the files to be recorded in the Wave Form format (“.wav” file extension). Once 
recorded the files are placed in the “\MATB\audio” sub-folder.  The filenames with the 
corresponding event XML file entry to play it are listed in Appendix Q.1.11.

Appendix Q.1 contains a list of 80 filenames along with the audio script for each. There are 40 each 
for OWN ship and OTHER ship, with 10 for each of the four radios in each ship category. The 
number of available files allows almost two communications events per minute without duplicates. 
As it is typical for flight deck crews to communicate with a number of air traffic controllers during 
the course of a flight, it would be appropriate for these recordings to be made by more than one 
individual’s voice. 

ATC radio communications protocol follows this format: 
Full call sign of the called aircraft 
Name of the ATC calling facility / function 
Request

Two prime reasons for this are the number of aircraft on frequency and that flight deck crews may be 
monitoring more than one radio simultaneously. As this is not the situation during a MATB run, the 
call sign will be repeated in place of the ATC calling facility / function.  While ICAO standards 
required that radio frequencies be communicated by speaking each number in a single format with 
“POINT” annunciated for the decimal point, it has become common practice in some regions to 
ignore this to save time. For instance, a COM radio frequency of “132.650” may be read back as 
"One thirty two sixty five”. While this may save time, there is less chance of misunderstanding 
adhering to the ICAO standard. The MATB scripts follow the ICAO standard.
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Q.1 Scripts / Audio Filename Pairs 

Q.1.1  NASA 504 Communications radio number ONE 

1.  OWN_COM1_124-575.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM ONE radio to frequency 
ONE TWO FOUR POINT FIVE SEVEN FIVE” 

2.  OWN_COM1_125-550.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM ONE radio to frequency 
ONE TWO FIVE POINT FIVE FIVE ZERO” 

3.  OWN_COM1_126-525.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM ONE radio to frequency 
ONE TWO SIX POINT FIVE TWO FIVE” 

4.  OWN_COM1_127-500.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM ONE radio to frequency 
ONE TWO SEVEN POINT FIVE ZERO ZERO” 

5.  OWN_COM1_128-475.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM ONE radio to frequency 
ONE TWO EIGHT POINT FOUR SEVEN FIVE” 

6.  OWN_COM1_129-450.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM ONE radio to frequency 
ONE TWO NINER POINT FOUR FIVE ZERO” 

7.  OWN_COM1_128-575.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM ONE radio to frequency 
ONE TWO EIGHT POINT FIVE SEVEN FIVE” 

8.  OWN_COM1_127-550.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM ONE radio to frequency 
ONE TWO SEVEN  POINT FIVE FIVE ZERO” 

9.  OWN_COM1_126-450.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM ONE radio to frequency 
ONE TWO SIX POINT FOUR FIVE ZERO” 

10.  OWN_COM1_125-500.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM ONE radio to frequency 
ONE TWO FIVE POINT FIVE ZERO ZERO” 
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Q.1.2  NASA 504 Communications radio number TWO 

11.  OWN_COM2_129-575.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM TWO radio to frequency 
ONE TWO NINER POINT FIVE SEVEN FIVE” 

12.  OWN_COM2_128-550.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM TWO radio to frequency 
ONE TWO EIGHT POINT FIVE FIVE ZERO” 

13.  OWN_COM2_127-525.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM TWO  radio to frequency 
ONE TWO SEVEN POINT FIVE TWO FIVE” 

14.  OWN_COM2_126-475.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM TWO radio to frequency 
ONE TWO SIX POINT FOUR SEVEN FIVE” 

15.  OWN_COM2_125-500.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM TWO radio to frequency 
ONE TWO FIVE POINT FIVE ZERO ZERO” 

16.  OWN_COM2_124-450.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM TWO radio to frequency 
ONE TWO FOUR POINT FOUR FIVE ZERO” 

17.  OWN_COM2_125-575.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR,  tune your COM TWO  radio to frequency 
ONE TWO FIVE POINT FIVE SEVEN FIVE” 

18.  OWN_COM2_126-550.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM TWO  radio to frequency 
ONE TWO SIX POINT FIVE FIVE ZERO” 

19.  OWN_COM2_127-500.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM TWO  radio to frequency 
ONE TWO SEVEN POINT FIVE ZERO ZERO” 

20.  OWN_COM2_128-525.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your COM TWO  radio to frequency 
ONE TWO EIGHT POINT FIVE TWO FIVE” 
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Q.1.3  NASA 504 Navigation radio number ONE 

21.  OWN_NAV1_110-650.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV ONE radio to frequency 
ONE ONE ZERO POINT SIX FIVE ZERO ” 

22.  OWN_ NAV1_111-600.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV ONE radio to frequency 
ONE ONE ONE POINT SIX ZERO ZERO” 

23.  OWN_ NAV1_112-550.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV ONE radio to frequency 
ONE ONE TWO POINT FIVE FIVE ZERO” 

24.  OWN_ NAV1_113-500.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV ONE radio to frequency 
ONE ONE THREE POINT FIVE ZERO ZERO” 

25.  OWN_ NAV1_114-450.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV ONE radio to frequency 
ONE ONE FOUR POINT FOUR FIVE ZERO” 

26.  OWN_ NAV1_115-400.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV ONE radio to frequency 
ONE ONE FIVE POINT FOUR ZERO ZERO” 

27.  OWN_ NAV1_114-650.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV ONE radio to frequency 
ONE ONE FOUR POINT SIX FIVE ZERO” 

28.  OWN_ NAV1_113-600.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV ONE radio to frequency 
ONE ONE THREE POINT SIX ZERO ZERO” 

29.  OWN_ NAV1_112-450.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV ONE radio to frequency 
ONE ONE TWO POINT FOUR FIVE ZERO” 

30.  OWN_ NAV1_111-500.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV ONE radio to frequency 
ONE ONE ONE POINT FIVE  ZERO ZERO” 
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Q.1.4  NASA 504 Navigation radio number TWO 

31.  OWN_NAV2_115-650.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV TWO  radio to frequency 
ONE ONE FIVE POINT SIX FIVE ZERO ” 

32.  OWN_ NAV2_114-600.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV TWO  radio to frequency 
ONE ONE FOUR  POINT SIX ZERO ZERO” 

33.  OWN_ NAV2_113-550.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV TWO radio to frequency 
ONE ONE THREE POINT FIVE FIVE ZERO” 

34.  OWN_ NAV2_112-450.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV TWO radio to frequency 
ONE ONE TWO POINT FOUR FIVE ZERO” 

35.  OWN_ NAV2_111-400.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV TWO radio to frequency 
ONE ONE ONE POINT FOUR ZERO ZERO” 

36.  OWN_ NAV2_110-500.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV TWO radio to frequency 
ONE ONE ZERO POINT FIVE ZERO ZERO” 

37.  OWN_ NAV2_111-650.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV TWO radio to frequency 
ONE ONE ONE POINT SIX FIVE ZERO” 

38.  OWN_ NAV2_112-600.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV TWO radio to frequency 
ONE ONE TWO POINT SIX ZERO ZERO” 

39.  OWN_ NAV2_113-500.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV TWO radio to frequency 
ONE ONE THREE POINT FIVE ZERO ZERO” 

40.  OWN_ NAV2_114-450.wav 
“NASA FIVE ZERO FOUR, NASA FIVE ZERO FOUR, tune your NAV TWO radio to frequency 
ONE ONE FOUR POINT FOUR FIVE ZERO” 
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Q.1.5  Other Ship Communications radio number ONE 

41.  OTHER_COM1_118-325.wav 
“CITRIS TWO ONE ONE, CITRIS TWO ONE ONE, tune your COM ONE radio to frequency 
ONE ONE EIGHT POINT THREE TWO FIVE” 

42.  OTHER_COM1_120-825.wav 
“ACEY FIVE ONE SEVEN ONE, ACEY FIVE ONE SEVEN ONE, tune your COM ONE radio to 
frequency ONE TWO ZERO POINT EIGHT TWO FIVE” 

43.  OTHER_COM1_124-350.wav 
“DELTA ONE FIVE ONE NINER, DELTA ONE FIVE ONE NINER, tune your COM ONE radio 
to frequency ONE TWO FOUR POINT THREE FIVE ZERO” 

44.  OTHER_COM1_126-175.wav 
“FEDEX THREE ZERO THREE, FEDEX THREE ZERO THREE, tune your COM ONE radio to 
frequency ONE TWO SIX POINT ONE SEVEN FIVE” 

45.  OTHER_COM1_127-725.wav 
“CITRIS NINER ZERO TWO,  CITRIS NINER ZERO TWO,  tune your COM ONE radio to 
frequency ONE TWO SEVEN POINT SEVEN TWO FIVE” 

46.  OTHER_COM1_128-525.wav 
“ACEY FIVE TWO EIGHT EIGHT, ACEY FIVE TWO EIGHT EIGHT, tune your COM ONE 
radio to frequency ONE TWO EIGHT POINT FIVE TWO FIVE” 

47.  OTHER_COM1_130-875.wav 
“UPS TWO ZERO SEVEN, UPS TWO ZERO SEVEN, tune your COM ONE radio to frequency 
ONE THREE ZERO POINT EIGHT SEVEN FIVE” 

48.  OTHER_COM1_132-950.wav 
“DELTA ONE SEVEN ZERO ONE, DELTA ONE SEVEN ZERO ONE, tune your COM ONE 
radio to frequency ONE THREE TWO  POINT NINER FIVE ZERO” 

49.  OTHER_COM1_134-175.wav 
“ACEY FIVE SIX TWO ZERO, ACEY FIVE SIX TWO ZERO, tune your COM ONE radio to 
frequency ONE THREE FOUR POINT ONE SEVEN FIVE” 

50.  OTHER_COM1_135-225.wav 
“CITRIS SIX FOUR TWO, CITRIS SIX FOUR TWO, tune your COM ONE radio to frequency 
ONE THREE FIVE POINT TWO TWO FIVE” 
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Q.1.6  Other Ship Communications radio number TWO 

51.  OTHER_COM2_118-275.wav 
“CITRIS TWO ONE ONE , CITRIS TWO ONE ONE, tune your COM TWO radio to frequency 
ONE ONE EIGHT POINT TWO SEVEN FIVE” 

52.  OTHER_COM2_120-775.wav 
“ACEY FIVE ONE SEVEN ONE, ACEY FIVE ONE SEVEN ONE, tune your COM TWO radio to 
frequency ONE TWO ZERO POINT SEVEN SEVEN FIVE” 

53.  OTHER_COM2_124-500.wav 
“DELTA ONE FIVE ONE NINER, DELTA ONE FIVE ONE NINER, tune your COM TWO  radio 
to frequency ONE TWO FOUR POINT FIVE ZERO ZERO” 

54.  OTHER_COM2_126-025.wav 
“FEDEX THREE ZERO THREE, FEDEX THREE ZERO THREE, tune your COM  TWO radio to 
frequency ONE TWO SIX POINT ZERO TWO FIVE” 

55.  OTHER_COM2_127-675.wav 
“CITRIS NINER ZERO TWO,  CITRIS NINER ZERO TWO,  tune your COM TWO radio to 
frequency ONE TWO SEVEN POINT SIX SEVEN FIVE” 

56.  OTHER_COM2_128-475.wav 
“ACEY FIVE TWO EIGHT EIGHT, ACEY FIVE TWO EIGHT EIGHT,  tune your COM TWO 
radio to frequency ONE TWO EIGHT POINT FOUR SEVEN FIVE” 

57.  OTHER_COM2_130-725.wav 
“UPS TWO ZERO SEVEN, UPS TWO ZERO SEVEN,  tune your COM TWO  radio to frequency 
ONE THREE ZERO POINT SEVEN TWO FIVE” 

58.  OTHER_COM2_132-800.wav 
“DELTA ONE SEVEN ZERO ONE, DELTA ONE SEVEN ZERO ONE, tune your COM TWO
radio to frequency ONE THREE TWO  POINT EIGHT ZERO ZERO” 

59.  OTHER_COM2_134-025.wav 
“ACEY FIVE SIX TWO ZERO, ACEY FIVE SIX TWO ZERO, tune your COM TWO  radio to 
frequency ONE THREE FOUR POINT ZERO TWO FIVE” 

60.  OTHER_COM2_135-175.wav 
“CITRIS SIX FOUR TWO, CITRIS SIX FOUR TWO,  tune your COM TWO  radio to frequency 
ONE THREE FIVE POINT ONE SEVEN FIVE” 
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Q.1.7  Other Ship Navigation radio number ONE 

61.  OTHER_NAV1_108-350.wav 
“CITRIS TWO ONE ONE , CITRIS TWO ONE ONE,  tune your NAV ONE radio to frequency 
ONE ZERO EIGHT POINT THREE FIVE ZERO ” 

62.  OTHER_ NAV1_109-250.wav 
“ACEY FIVE ONE SEVEN ONE, ACEY FIVE ONE SEVEN ONE, tune your NAV ONE radio to 
frequency ONE ZERO NINER  POINT TWO FIVE ZERO” 

63.  OTHER_ NAV1_110-400.wav 
“DELTA ONE FIVE ONE NINER, DELTA ONE FIVE ONE NINER, tune your NAV  ONE radio 
to frequency ONE ONE ZERO POINT FOUR ZERO ZERO” 

64.  OTHER_ NAV1_111-950.wav 
“FEDEX THREE ZERO THREE, FEDEX THREE ZERO THREE, tune your NAV ONE radio to 
frequency ONE ONE ONE POINT NINER FIVE ZERO” 

65.  OTHER_ NAV1_112-150.wav 
“CITRIS NINER ZERO TWO,  CITRIS NINER ZERO TWO,  tune your NAV ONE radio to 
frequency ONE ONE TWO POINT ONE FIVE ZERO” 

66.  OTHER_ NAV1_113-000.wav 
“ACEY FIVE TWO EIGHT EIGHT, ACEY FIVE TWO EIGHT EIGHT,  tune your NAV ONE 
radio to frequency ONE ONE THREE POINT ZERO ZERO ZERO” 

67.  OTHER_ NAV1_114-500.wav 
“UPS TWO ZERO SEVEN, UPS TWO ZERO SEVEN, tune your NAV ONE radio to frequency 
ONE ONE FOUR POINT FIVE ZERO ZERO” 

68.  OTHER_ NAV1_115-750.wav 
“DELTA ONE SEVEN ZERO ONE, DELTA ONE SEVEN ZERO ONE, tune your NAV ONE 
radio to frequency ONE ONE FIVE POINT SEVEN FIVE ZERO” 

69.  OTHER_ NAV1_116-450.wav 
“ACEY FIVE SIX TWO ZERO, ACEY FIVE SIX TWO ZERO, tune your NAV ONE radio to 
frequency ONE ONE SIX POINT FOUR FIVE ZERO” 

70.  OTHER_ NAV1_117-650.wav 
“CITRIS SIX FOUR TWO, CITRIS SIX FOUR TWO,  tune your NAV ONE radio to frequency 
ONE ONE SEVEN POINT SIX FIVE ZERO” 
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Q.1.8  Other Ship Navigation radio number TWO 

71.  OTHER_NAV2_108-750.wav 
“CITRIS TWO ONE ONE , CITRIS TWO ONE ONE, tune your NAV TWO  radio to frequency 
ONE ZERO EIGHT POINT SEVEN FIVE ZERO ” 

72.  OTHER_ NAV2_109-650.wav 
“ACEY FIVE ONE SEVEN ONE, ACEY FIVE ONE SEVEN ONE, tune your NAV TWO  radio to 
frequency ONE ZERO NINER  POINT SIX FIVE ZERO” 

73.  OTHER_ NAV2_110-800.wav 
“DELTA ONE FIVE ONE NINER, DELTA ONE FIVE ONE NINER, tune your NAV  TWO radio 
to frequency ONE ONE ZERO POINT EIGHT ZERO ZERO” 

74.  OTHER_ NAV2_111-350.wav 
“FEDEX THREE ZERO THREE, FEDEX THREE ZERO THREE, tune your NAV TWO radio to 
frequency ONE ONE ONE POINT THREE FIVE ZERO” 

75.  OTHER_ NAV2_112-550.wav 
“CITRIS NINER ZERO TWO,  CITRIS NINER ZERO TWO, tune your NAV TWO radio to 
frequency ONE ONE TWO POINT FIVE FIVE ZERO” 

76.  OTHER_ NAV2_113-400.wav 
“ACEY FIVE TWO EIGHT EIGHT, ACEY FIVE TWO EIGHT EIGHT, tune your NAV TWO 
radio to frequency ONE ONE THREE POINT FOUR ZERO ZERO” 

77.  OTHER_ NAV2_114-900.wav 
“UPS TWO ZERO SEVEN, UPS TWO ZERO SEVEN, tune your NAV TWO radio to frequency 
ONE ONE FOUR POINT NINER ZERO ZERO” 

78.  OTHER_ NAV2_115-050.wav 
“DELTA ONE SEVEN ZERO ONE, DELTA ONE SEVEN ZERO ONE, tune your NAV TWO 
radio to frequency ONE ONE FIVE POINT ZERO FIVE ZERO” 

79.  OTHER_ NAV2_116-850.wav 
“ACEY FIVE SIX TWO ZERO, ACEY FIVE SIX TWO ZERO, tune your NAV TWO radio to 
frequency ONE ONE SIX POINT EIGHT FIVE ZERO” 

80.  OTHER_ NAV2_117-950.wav 
“CITRIS SIX FOUR TWO, CITRIS SIX FOUR TWO,  tune your NAV TWO radio to frequency 
ONE ONE SEVEN POINT NINER FIVE ZERO” 
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Q.1.9  Airline Call Signs 

CALL SIGN AIRLINE 
American American Airlines 
Acey Atlantic Southeast Airlines, Inc. (ASA) 
Amtran ATA Airlines 
Cactus American West Airlines 
Citris Air Tran Airlines 
Continental Continental Airlines 
Delta Delta Airlines 
Dynasty China Airlines 
FedEx  Federal Express 
Shamrock Aer Lingus 
Southwest Southwest Airlines 
Speedbird British Airways 
United United Airlines 
UPS United Parcel Service 
US Air US Airways 
Virair Virgin Atlantic Airways 
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Q.1.10 FAA Radiotelephony Phonetic Alphabet with Pronunciation 



Appendix Page 166 

Q.1.11  Audio Filename with Corresponding Events File Entry 

# Audio Filename MATB_EVENT XML File Entry 
1 OWN_COM1_124-575.wav <comm> 

      <ship>OWN</ship> 
      <radio>COM1</radio> 
      <freq>124.575</freq> 
</comm>

2 OWN_COM1_125-550.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM1</radio> 
      <freq>125.550</freq> 
</comm> 

3 OWN_COM1_126-525.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM1</radio> 
      <freq>126.525</freq> 
</comm> 

4 OWN_COM1_127-500.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM1</radio> 
      <freq>127.500</freq> 
</comm> 

5 OWN_COM1_128-475.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM1</radio> 
      <freq>128.475</freq> 
</comm> 

6 OWN_COM1_129-450.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM1</radio> 
      <freq>129.450</freq> 
</comm> 

7 OWN_COM1_128-575.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM1</radio> 
      <freq>128.575</freq> 
</comm> 

8 OWN_COM1_127-550.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM1</radio> 
      <freq>127.550</freq> 
</comm> 
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# Audio Filename MATB_EVENT XML File Entry 
9 OWN_COM1_126-450.wav <comm> 

      <ship>OWN</ship> 
      <radio>COM1</radio> 
      <freq>126.450</freq> 
</comm> 

10 OWN_COM1_125-500.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM1</radio> 
      <freq>125.500</freq> 
</comm> 

11 OWN_COM2_129-575.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM2</radio> 
      <freq>129.575</freq> 
</comm>

12 OWN_COM2_128-550.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM2</radio> 
      <freq>128.550</freq> 
</comm>

13 OWN_COM2_127-525.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM2</radio> 
      <freq>127.525</freq> 
</comm>

14 OWN_COM2_126-475.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM2</radio> 
      <freq>126.475</freq> 
</comm>

15 OWN_COM2_125-500.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM2</radio> 
      <freq>125.500</freq> 
</comm>

16 OWN_COM2_124-450.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM2</radio> 
      <freq>124.450</freq> 
</comm>
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# Audio Filename MATB_EVENT XML File Entry 
17 OWN_COM2_125-575.wav <comm> 

      <ship>OWN</ship> 
      <radio>COM2</radio> 
      <freq>125.575</freq> 
</comm> 

18 OWN_COM2_126-550.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM2</radio> 
      <freq>126.550</freq> 
</comm> 

19 OWN_COM2_127-500.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM2</radio> 
      <freq>127.500</freq> 
</comm>

20 OWN_COM2_128-525.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM2</radio> 
      <freq>128.525</freq> 
</comm>

21 OWN_NAV1_110-650.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV1</radio> 
      <freq>110.650</freq> 
</comm>

22 OWN_ NAV1_111-600.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV1</radio> 
      <freq>111.600</freq> 
</comm>

23 OWN_ NAV1_112-550.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV1</radio> 
      <freq>112.550</freq> 
</comm>

24 OWN_ NAV1_113-500.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV1</radio> 
      <freq>113.500</freq> 
</comm>
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# Audio Filename MATB_EVENT XML File Entry 
25 OWN_ NAV1_114-450.wav <comm> 

      <ship>OWN</ship> 
      <radio>NAV1</radio> 
      <freq>114.450</freq> 
</comm> 

26 OWN_ NAV1_115-400.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV1</radio> 
      <freq>115.400</freq> 
</comm> 

27 OWN_ NAV1_114-650.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV1</radio> 
      <freq>114.650</freq> 
</comm>

28 OWN_ NAV1_113-600.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV1</radio> 
      <freq>113.600</freq> 
</comm>

29 OWN_ NAV1_112-450.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV1</radio> 
      <freq>112.450</freq> 
</comm>

30 OWN_ NAV1_111-500.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV1</radio> 
      <freq>111.500</freq> 
</comm>

31 OWN_NAV2_115-650.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV2</radio> 
      <freq>115.650</freq> 
</comm>

32 OWN_ NAV2_114-600.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV2</radio> 
      <freq>114.600</freq> 
</comm>
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# Audio Filename MATB_EVENT XML File Entry 
33 OWN_ NAV2_113-550.wav <comm> 

      <ship>OWN</ship> 
      <radio>NAV2</radio> 
      <freq>113.550</freq> 
</comm> 

34 OWN_ NAV2_112-450.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV2</radio> 
      <freq>112.450</freq> 
</comm> 

35 OWN_ NAV2_111-400.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV2</radio> 
      <freq>111.400</freq> 
</comm>

36 OWN_ NAV2_110-500.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV2</radio> 
      <freq>110.500</freq> 
</comm>

37 OWN_ NAV2_111-650.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV2</radio> 
      <freq>111.650</freq> 
</comm>

38 OWN_ NAV2_112-600.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV2</radio> 
      <freq>112.600</freq> 
</comm>

39 OWN_ NAV2_113-500.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV2</radio> 
      <freq>113.500</freq> 
</comm>

40 OWN_ NAV2_114-450.wav <comm> 
      <ship>OWN</ship> 
      <radio>NAV2</radio> 
      <freq>114.450</freq> 
</comm>



Appendix Page 171 

# Audio Filename MATB_EVENT XML File Entry 
41 OTHER_COM1_118-325.wav <comm> 

      <ship>OTHER</ship> 
      <radio>COM1</radio> 
      <freq>118.325</freq> 
</comm> 

42 OTHER_COM1_120-825.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM1</radio> 
      <freq>120.825</freq> 
</comm> 

43 OTHER_COM1_124-350.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM1</radio> 
      <freq>124.350</freq> 
</comm>

44 OTHER_COM1_126-175.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM1</radio> 
      <freq>126.175</freq> 
</comm>

45 OTHER_COM1_127-725.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM1</radio> 
      <freq>127.725</freq> 
</comm>

46 OTHER_COM1_128-525.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM1</radio> 
      <freq>128.525</freq> 
</comm>

47 OTHER_COM1_130-875.wav <comm> 
      <ship>OWN</ship> 
      <radio>COM1</radio> 
      <freq>130.875</freq> 
</comm>

48 OTHER_COM1_132-950.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM1</radio> 
      <freq>132.950</freq> 
</comm>
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# Audio Filename MATB_EVENT XML File Entry 
49 OTHER_COM1_134-175.wav <comm> 

      <ship>OTHER</ship> 
      <radio>COM1</radio> 
      <freq>134.175</freq> 
</comm> 

50 OTHER_COM1_135-225.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM1</radio> 
      <freq>135.225</freq> 
</comm> 

51 OTHER_COM2_118-275.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM2</radio> 
      <freq>118.275</freq> 
</comm>

52 OTHER_COM2_120-775.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM2</radio> 
      <freq>120.775</freq> 
</comm>

53 OTHER_COM2_124-500.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM2</radio> 
      <freq>124.500</freq> 
</comm>

54 OTHER_COM2_126-025.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM2</radio> 
      <freq>126.025</freq> 
</comm>

55 OTHER_COM2_127-675.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM2</radio> 
      <freq>127.675</freq> 
</comm>

56 OTHER_COM2_128-475.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM2</radio> 
      <freq>128.475</freq> 
</comm>
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# Audio Filename MATB_EVENT XML File Entry 
57 OTHER_COM2_130-725.wav <comm> 

      <ship>OTHER</ship> 
      <radio>COM2</radio> 
      <freq>130.725</freq> 
</comm> 

58 OTHER_COM2_132-800.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM2</radio> 
      <freq>132.800</freq> 
</comm> 

59 OTHER_COM2_134-025.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM2</radio> 
      <freq>134.025</freq> 
</comm>

60 OTHER_COM2_135-175.wav <comm> 
      <ship>OTHER</ship> 
      <radio>COM2</radio> 
      <freq>135.175</freq> 
</comm>

61 OTHER_NAV1_108-350.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV1</radio> 
      <freq>108.350</freq> 
</comm>

62 OTHER_ NAV1_109-250.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV1</radio> 
      <freq>109.250</freq> 
</comm>

63 OTHER_ NAV1_110-400.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV1</radio> 
      <freq>110.400</freq> 
</comm>

64 OTHER_ NAV1_111-950.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV1</radio> 
      <freq>111.950</freq> 
</comm>
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# Audio Filename MATB_EVENT XML File Entry 
65 OTHER_ NAV1_112-150.wav <comm> 

      <ship>OTHER</ship> 
      <radio>NAV1</radio> 
      <freq>112.150</freq> 
</comm> 

66 OTHER_ NAV1_113-000.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV1</radio> 
      <freq>113.000</freq> 
</comm> 

67 OTHER_ NAV1_114-500.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV1</radio> 
      <freq>114.500</freq> 
</comm>

68 OTHER_ NAV1_115-750.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV1</radio> 
      <freq>115.750</freq> 
</comm>

69 OTHER_ NAV1_116-450.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV1</radio> 
      <freq>116.450</freq> 
</comm>

70 OTHER_ NAV1_117-650.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV1</radio> 
      <freq>117.650</freq> 
</comm>

71 OTHER_NAV2_108-750.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV2</radio> 
      <freq>108.750</freq> 
</comm>

72 OTHER_ NAV2_109-650.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV2</radio> 
      <freq>109.650</freq> 
</comm>
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# Audio Filename MATB_EVENT XML File Entry 
73 OTHER_ NAV2_110-800.wav <comm> 

      <ship>OTHER</ship> 
      <radio>NAV2</radio> 
      <freq>110.800</freq> 
</comm> 

74 OTHER_ NAV2_111-350.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV2</radio> 
      <freq>111.350</freq> 
</comm> 

75 OTHER_ NAV2_112-550.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV2</radio> 
      <freq>112.550</freq> 
</comm>

76 OTHER_ NAV2_113-400.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV2</radio> 
      <freq>113.400</freq> 
</comm>

77 OTHER_ NAV2_114-900.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV2</radio> 
      <freq>114.900</freq> 
</comm>

78 OTHER_ NAV2_115-050.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV2</radio> 
      <freq>115.050</freq> 
</comm>

79 OTHER_ NAV2_116-850.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV2</radio> 
      <freq>116.850</freq> 
</comm>

80 OTHER_ NAV2_117-950.wav <comm> 
      <ship>OTHER</ship> 
      <radio>NAV2</radio> 
      <freq>117.950</freq> 
</comm>
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